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PROPRIETARY INFORMATION 
The material contained herein constitutes proprietary and confidential information, and is the intellectual 
property of Siemens Mobility, Inc., Rail Automation (Siemens) protected under United States patent, 
copyright and/or other laws and international treaty provisions. This information and the software it 
describes are for authorized use only, and may not be: (i) modified, translated, reverse engineered, 
decompiled, disassembled or used to create derivative works; (ii) copied or reproduced for any reason 
other than specific application needs; or (iii) rented, leased, lent, sublicensed, distributed, remarketed, or 
in any way transferred; without the prior written authorization of Siemens. This proprietary notice and any 
other associated labels may not be removed.  

TRANSLATIONS 
The manuals and product information of Siemens Mobility, Inc. are intended to be produced and read in 
English. Any translation of the manuals and product information are unofficial and can be imprecise and 
inaccurate in whole or in part. Siemens Mobility, Inc. does not warrant the accuracy, reliability, or 
timeliness of any information contained in any translation of manual or product information from its 
original official released version in English and shall not be liable for any losses caused by such reliance 
on the accuracy, reliability, or timeliness of such information. Any person or entity that relies on 
translated information does so at his or her own risk. 

WARRANTY INFORMATION 
Siemens Mobility, Inc. warranty policy is as stated in the current Terms and Conditions of Sale 
document. Warranty adjustments will not be allowed for products or components which have been 
subjected to abuse, alteration, improper handling, or installation, or which have not been operated in 
accordance with Seller's instructions. Alteration or removal of any serial number or identification mark 
voids the warranty. 

SALES AND SERVICE LOCATIONS 
Technical assistance and sales information on Siemens Mobility, Inc. products may be obtained at the 
following locations: 
 

SIEMENS MOBILITY, INC. RAIL AUTOMATION SIEMENS MOBILITY, INC. RAIL AUTOMATION 

2400 NELSON MILLER PARKWAY 939 S. MAIN STREET 

LOUISVILLE, KENTUCKY 40223 MARION, KENTUCKY 42064 

TELEPHONE:  (502) 618-8800 TELEPHONE:  (270) 918-7800 
FAX:  (502) 618-8810 CUSTOMER SERVICE:  (800) 626-2710 
SALES & SERVICE:  (800) 626-2710 TECHNICAL SUPPORT:  (800) 793-7233 
WEB SITE:  USA Rail Automation Site FAX: (270) 918-7830 

FCC RULES COMPLIANCE 
The equipment covered in this manual has been tested and found to comply with the limits for Class A 
digital devices, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial environment. 
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his/her own expense. 

http://w3.usa.siemens.com/mobility/us/en/feight-rail/rail-automation
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NOTES, CAUTIONS, AND WARNINGS 
Throughout this manual, notes, cautions, and warnings are frequently used to direct the reader’s 
attention to specific information. Use of the three terms is defined as follows: 
 

 

 

  
 

WARNING 
INDICATES A POTENTIALLY HAZARDOUS SITUATION WHICH, IF NOT 
AVOIDED, COULD RESULT IN DEATH OR SERIOUS INJURY. 
WARNINGS ALWAYS TAKE PRECEDENCE OVER NOTES, CAUTIONS, 
AND ALL OTHER INFORMATION. 

  

 
 

  

CAUTION 
REFERS TO PROPER PROCEDURES OR PRACTICES WHICH IF NOT 
STRICTLY OBSERVED, COULD RESULT IN A POTENTIALLY 
HAZARDOUS SITUATION AND/OR POSSIBLE DAMAGE TO EQUIPMENT. 
CAUTIONS TAKE PRECEDENCE OVER NOTES AND ALL OTHER 
INFORMATION, EXCEPT WARNINGS. 

  

 

 

NOTE 
Generally used to highlight certain information relating to the topic under 
discussion. 

 
 
If there are any questions, contact Siemens Mobility, Inc. Application Engineering 
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ELECTROSTATIC DISCHARGE (ESD) PRECAUTIONS  
Static electricity can damage electronic circuitry, particularly low voltage components such as the 
integrated circuits commonly used throughout the electronics industry. Therefore, procedures have been 
adopted industry-wide which make it possible to avoid the sometimes invisible damage caused by 
electrostatic discharge (ESD) during the handling, shipping, and storage of electronic modules and 
components. Siemens Mobility, Inc. has instituted these practices at its manufacturing facility and 
encourages its customers to adopt them as well to lessen the likelihood of equipment damage in the field 
due to ESD. Some of the basic protective practices include the following:  
 

• Ground yourself before touching card cages, assemblies, modules, or components.  
• Remove power from card cages and assemblies before removing or installing modules.  
• Remove circuit boards (modules) from card cages by the ejector lever only. If an ejector lever is 

not provided, grasp the edge of the circuit board but avoid touching circuit traces or components.  
• Handle circuit boards by the edges only.  
• Never physically touch circuit board or connector contact fingers or allow these fingers to come in 

contact with an insulator (e.g., plastic, rubber, etc.).  
• When not in use, place circuit boards in approved static-shielding bags, contact fingers first. 

Remove circuit boards from static-shielding bags by grasping the ejector lever or the edge of the 
board only. Each bag should include a caution label on the outside indicating static-sensitive 
contents.  

• Cover workbench surfaces used for repair of electronic equipment with static dissipative 
workbench matting.  

• Utilize only anti-static cushioning material in equipment shipping and storage containers. 
 

For information concerning ESD material applications, please contact the Technical Support Staff at  
1-800-793-7233. 
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GLOSSARY 
 

TERM DESCRIPTION 

AAR Association of American Railroads – An organization that establishes 
uniformity and standardization among different railroad systems. 

AC Alternating current 

AREMA American Railroad Equipment Manufacturing Association – An organization 
that supersedes AAR. 

ATCS Advanced Train Control System – A set of standards compiled by the AAR 
for controlling all aspects of train operation. 

CFR Code of Federal Regulations 

DHCP Dynamic Host Configuration Protocol 

ECD External Configuration Device – A serial EEPROM (Flash Memory) device 
mounted inside the chassis of the GEO unit. The ECD is used to store site-
specific configuration data (MCF, SIN, UCN, and card parameters) for the 
CPU.  

EX Value the phase of the received signal, which is the measure of the impedance of 
the track ballast. This measurement identifies how much current is leaking 
from one rail to another. 

EZ Value the measure of the received signal level. 

GCP Grade Crossing Predictor 

GFT Ground Fault Tester 

I/O Input/Output 

IP Internet Protocol 

IPv4 Internet Protocol version 4 

MEF Module Executable File – The executive software running in the CPU or I/O 
Modules. The user can download the MEF through the Diag port to update 
the software. 

MCF Module Configuration File – The GCP application logic file. 

MCT MCF Configuration Tool 
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TERM DESCRIPTION 

SIN Site Identification Number – The 12-digit ATCS address for the SIN has the 
form 7.RRR.LLL.GGG.SS stored in binary coded decimal, with each digit in 
one nibble. The digit 0 is represented by “A” and 0 is used as a null byte. 

Site Location the location where GCP unit is installed. 

TCP Transmission Control Protocol 

UDP User Datagram Protocol 

UI User Interface 

VPI Vital Parallel Input – A module input circuit the function of which affects the 
safety of train operation. 

VRO Vital Relay Output – A module output circuit the function of which affects the 
safety of train operation. 

Web UI Web-browser User Interface 

WI Wayside Inspector 

WiMag Wireless Magnetometer 
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CHAPTER 1 – INTRODUCTION 

1.1 PURPOSE 

This manual provides the information needed by application engineers to create Module Configuration 
Files (MCFs) for and to program the Wayside Inspector (WI) for use at crossings. This manual provides 
information to program the WI for usage of AC power, batteries, battery chargers, crossing warning 
systems including the Solid State Crossing Controller (SSCC), relay controlled crossing wiring, Grade 
Crossing Predictor (GCP) connections, the Ground Fault Tester 2, and Wireless Magnetometers. 

1.2 SCOPE 

This manual is useful to application engineering personnel intending to program the WI for crossing 
monitoring. This manual does not address any railroad specific crossing guidelines. This manual 
provides an overview of the wiring but should not be used as a guide to the installation of the WI. For 
installation procedures and general installation instructions, see the Wayside Inspector Installation & 
Instruction Manual, SIG-00-16-03. 
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1.3 REFERENCE MATERIAL 

Table 1-1   Reference Documents 

Component Manual Title Document Number 

Battery Charger Series SJ Battery Chargers SIG-00-00-18 

Model 4000 Grade 
Crossing Predictor 

Model 4000 Grade Crossing Predictor (GCP 4000)  
Field Manual SIG-00-08-10 

Model 4000 Grade Crossing Predictor Plus  
(Model 4000 GCP Plus) Field Manual 

SIG-00-12-68 

Model 4000 Grade Crossing Predictor (GCP 4000) 
Application Guidelines SIG-00-08-06 

Model 5000 Grade 
Crossing Predictor 

Model 5000 Grade Crossing Predictor (GCP 5000)  
Field Manual SIG-00-13-03 

Model 5000 Grade Crossing Predictor (GCP 5000) 
Application Guidelines SIG-00-13-04 

Model 3000+ Grade 
Crossing Predictor 

Model 3000+ Grade Crossing Predictor (GCP 3000+) 
Application Guidelines SIG-00-17-04 

Model 3000+ Grade Crossing Predictor (GCP 3000+)  
Field Manual SIG-00-18-01 

Model 3000+ Grade Crossing Predictor (GCP 3000+) 
Instruction and Installation SIG-00-17-03 

Electronic Bell User Guide, A80301 SIG-00-04-09 

Ground Fault Tester 
Ground Fault Tester, A80297-01, -02, -03  SIG-00-03-05-003 

Ground Fault Tester 2 (GFT2), A81010-01, -02 SIG-00-15-06 

Mini Trackside Sensor 
Package 

User Guide. Part of SEAR II accessory group, includes 
MTSS (A80285, A80286-2), Gate Tip Sensor (A80281) and 
Electronic Bell (A80301) 

SIG-00-03-05-001 

Solid State Crossing 
Controller 

Solid State Crossing Controller IIIA (SSCCIIIA) 
A91160 & 91165 SIG-00-02-12 

Solid State Crossing Controller III Plus (SSCCIIIPlus) 
A91190 & 91195 SIG-00-02-03 

Solid State Crossing Controller IV (SSCCIV) 
A91210 & 91215 SIG-00-03-02 

Wayside Inspector Wayside Inspector Installation and Instruction Manual SIG 00-16-03 

Wayside Inspector MCF Configuration Tool Application Guidelines Manual SIG 00-16-05 

Wayside Inspector Wayside Inspector Web Application User Manual SIG-00-20-02 
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CHAPTER 2 – WAYSIDE INSPECTOR OVERVIEW  

 WARNING
 

THE WAYSIDE INSPECTOR IS A NON-VITAL PRODUCT. 
CAUTION MUST BE TAKEN WHEN INTERFACING THE WAYSIDE 
INSPECTOR TO ANY VITAL SIGNAL OR CROSSING EQUIPMENT AS 
THE WAYSDE INSPECTOR CANNOT BE USED TO PERFORM, 
EITHER DIRECTLY OR INDIRECTLY, ANY VITAL FUNCTIONS. 
ENSURE THE WAYSIDE INSPECTOR IS INSTALLED PER 
MANUFACTURER’S INSTRUCTIONS, AND/OR ALL EQUIPMENT 
INTERCONNECTIONS ARE IN COMPLIANCE WITH RAILROAD 
PROCEDURES AND SPECIFICATIONS.  

 
The Wayside Inspector (WI) system automates periodic inspections for crossings by monitoring 
the state of discrete I/O signals, battery voltages, and AC power at a crossing. From that 
information, the WI analyzes the operation of the crossing warning system and automatically 
performs periodic inspections of the crossing warning system. The WI can send alarms and 
automated inspection results to an office system using several possible communications 
methods. The inspections are performed by the WI by executing programmable logic contained 
in a Module Configuration File (MCF). Figure 2-1 shows the context of the WI installed at a 
crossing. 

Wayside
Inspector

GFT 
(or GFT2)

Comms 
System

Crossing 
Batteries

Crossing 
Warning 
System

AC Power 
Relay

WiMag 
System

MCF Config 
Tool

Fault
Status

Battery
Voltage

Digital
I/O

UDP

AC Pwr
Control

AC Power AC Pwr
Input

MCF

GCP 4000/
5000/3000+

Crossing
Status

Application
Engineer

Field
Personnel

Web

MTSS

Gate/Bell
Status

Gate Tip 
Sensor

eBellGate Mech 
Contacts

Legacy GCP 
3000

Logs/Config

Office 
System

Office
Personnel  

Figure 2-1   Context of WI Installed at Crossing 
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The WI monitors the crossing warning system I/O using digital inputs. The WI monitors the 
battery system voltages using analog inputs. The WI can turn off the battery chargers using an 
AC power control relay. The WI monitors the system for ground faults using the Siemens 
Ground Fault Tester 2 (GFT2). 
If the crossing uses a Siemens Gate Crossing Predictor (GCP), the WI can receive crossing 
statuses over a message interface instead of using input wiring. In addition, the WI can receive 
train speed and direction information in GCP messages. 
In situations where the typical crossing I/O cannot provide the direction or route information 
needed for the warning time test, the installation can add Wireless Magnetometer (WiMag) 
sensors to detect trains. The WI can receive the WiMag sensor statuses over a network. 
Field personnel interact with the WI using a web browser user interface (WebUI). The WebUI 
allows field personnel to adjust system settings, view status, view inspection results, and 
download logs. 
Because each location (or class of locations) is different, the WI uses programmable logic to 
execute the inspections. The logic is loaded into the WI as a Module Configuration File (MCF). 
The MCF includes configuration settings and relay logic. An application engineer defines the 
logic and settings using the MCF Configuration Tool (MCT). 
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CHAPTER 3 – MCF CONFIGURATION TOOL 

Application engineers use the MCF Configuration Tool to create the Module Configuration File 
(MCF). The MCF contains the site-specific logic and default settings for the location. The 
application engineer should be familiar with crossing warning systems to create effective MCF 
logic. The MCF logic defines the relationships between the various inputs, outputs, inspections, 
and alarms. 
 

3.1 INSTALLING THE MCF CONFIGURATION TOOL 

To install the MCF Configuration Tool: 
1. Locate the MCF Configuration Tool Software installation files. 
2. Locate and double-click the setup.exe file. This file is located in the root folder: 

MCT.x.x.x where x.x.x is the version. 
3. A dialog box will appear. Follow the instructions to install the software. 

a. Click on install if prompted to install the Microsoft Visual C++ Redistributable 
Package for the MCF Configuration Tool. 

 
b. Click on ‘Next’ when the InstallShield Wizard appears. 
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c. Accept all the terms of the License Agreement by selecting ‘Yes’. 
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d. Choose the Destination Location or accept the default and then select next. 

 
e. Review the selection and select ‘Next’ to start the installation. 
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f. Select ‘Yes’ to review the Readme File or select ‘No’. 

 
g. The InstallShield Wizard Complete dialog box will appear. Select Finish to 

complete the installation. 

 
4. The user can now open the MCT from the start menu. 
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3.2 UNINSTALLING THE MCF CONFIGURATION TOOL 

To uninstall the MCF Configuration Tool: 
1. Select Settings/App & Feature from the start menu. 
2. Search for MCF Configuration Tool. 
3. Select ‘Uninstall’  
4. Confirm that you want to uninstall the software. 
5. The InstallShield Wizard will appear. 
6. Select ‘Yes’ to remove the MCF Configuration Tool from this computer. 

 
7. Select ‘Finish” when the ‘Uninstall Complete’ Wizard screen appears. 

 
8. The MCF configuration Tool is now uninstalled from the computer. 
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3.3 CREATING A PROJECT, FILE LOCATIONS AND WORKSPACE 

To create a new project, click the “New” button on the tool bar or select File > New from the 
menu. 
When a new project is created, the dialog box shown in Figure 3-1 will appear. 
 

 
Figure 3-1   New Project Dialog Box 

 
The WI is currently the only product supported by the MCF Configuration Tool. 
For the Card Definition package, select the latest version for a new project. If the MCF is for 
older revisions of executive software in the WI, the user may need to select a different Card 
Definition Package. Refer to Table 3-1 to select the card definition that goes with the WI 
executive version. 
 

Table 3-1   Card Definition Package Usage 

WI Executive version Card Definition Package 

9VD17-A01E and older 

(nvWI_mef_1.5.2r.tgz) 

card_desc_wi04.zip 

9VD17-A01F and newer 

(nvWI_mef_1.6.20r.tgz) 

card_desc_wi08.zip 

 
Enter the name of the project. A folder with that project name is created at the location shown in 
“Location” listed in the dialog box. The location shows the path of the MCF Configuration Tool 
workspace location. 
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Once all the fields are set, click the OK button. 
A folder is created at C:\Siemens\MCFConfigurationTool\workspace with several subfolders and 
files, as shown in Figure 3-2. 
 

 
Figure 3-2   Subfolders and Files 

 
The *.ui.xml file contains all the information for the MCF Configuration Tool. It will be named the 
same as the name of the project. In this example, the project was named “ManualMCF” and the 
folders and files shown in Figure 3-2 are located in the folder: 
“C:\Siemens\MCFConfigurationTool\workspace\ManualMCF”. 
 

3.4 OPENING AN EXISTING PROJECT 

To open an existing project: 
• Click the “Open” icon on the tool bar or click File > Open from the menu. A standard “File 

Open” dialog box will display by default in the workspace location: 
C:\Siemens\MCFConfigurationTool\workspace 

• Double-click the subfolder of the project to be opened. 
• Select the *.ui.xml file of the project. 
• Click Open. The selected project will open and can be edited. 
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3.5 CHANGING THE WORKSPACE FOLDER 

The workspace is a directory on the disk where the MCT creates the project folder and stores all 
the project related information. The user can change this at any time from the application. 
To change the workspace, go to File > Workspace and select or create the new directory for the 
new workspace location, as shown below. 
 

 
 

• Click on the “Make New Folder” button to create a new folder for the workspace location. 
• Click on “OK” to save the new workspace directory. 
• Click on “Cancel” to abort the operation. 

 

3.6 EDITING CONFIGURATION PARAMETERS AND LOGIC STATE NAMES 

The application engineer edits the MCF configuration parameters and names logic state 
variables using the WI Editor. The WI Editor is shown when the user clicks the WI Editor icon on 
the toolbar (as shown in Figure 3-3) or when the user selects Edit  WI from the menu bar. 
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Figure 3-3   WI Editor Icon 

The WI Editor screen has three main areas as shown in Figure 3-4: 

• the configuration item list 
• the configuration parameters 
• the logic states. 

 
Figure 3-4   WI Editor Screen Areas 
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Select the specific configuration items to view in the configuration item list and corresponding 
configuration parameters and logic states for the selected configuration item will be displayed. 
The following list shows the available configuration items: 
 

• General 
• AC Power 
• State Names 
• Digital Inputs 
• Analog Inputs 
• Relay Outputs 
• LEDs 
• Alarms 
• Inspections 
• WiMag Sensor Systems 
• Speed Measurements 
• GCP Interface 
• iLODs 
 

Chapter 4 of this manual provides details for the configuration parameters and logic states for 
each configuration item. 
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3.7 EDITING LOGIC DATA 

The application engineer edits the Boolean variables, timers, properties, and submenus using 
the Logic Data Editor. The Logic Data Editor is shown when the user clicks the Logic Data icon 
on the toolbar (as shown in Figure 3-5) or when the user selects Edit  Logic Data from the 
menu bar. 

 
Figure 3-5   Logic Data Editor Screen 

 

3.7.1 BOOLEAN VARIABLES 

The application engineer may add and remove intermediate Boolean variables in the Logic Data 
editor. 

3.7.1.1 ADDING A BOOLEAN VARIABLE 
To add a Boolean variable, select “Boolean Variables” on the left and then click the “Add” icon 
on the toolbar. The user can name the variable, set the initial state of the variable, and provide a 
comment on the new variable. The variable name is used in the relay logic equations. 

3.7.1.2 DELETING A BOOLEAN VARIABLE 
To delete a Boolean variable, select “Boolean Variables” on the left, select the variable in the 
table of variables on the right, then click the “Delete” icon in the toolbar. 
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3.7.2 TIMERS 

The WI supports timer relay coils in the relay logic. Each timer has a logic state to start the timer 
and a logic state indicating if the timer has expired or not. The start logic state must remain set 
for the timer to run.  
Figure 3-6 shows the timers screen in the MCF Configuration Tool. 
 

 
Figure 3-6   Logic Data: Timers Screen 

 
Each timer has the configuration options described in Table 3-2. 
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Table 3-2   Logic Data: Timers Options 

Option Description 

Timer Name The name of the timer as displayed on the web-browser user 
interface. Field personnel will see this name when adjusting the 
timer duration on the web-browser user interface. 

Timer Start LS Name The variable name for the timer start logic state, which is set by the 
relay logic equations. 

Timer Expired LS Name The variable name for the timer expired logic state, which is read 
by the relay logic equations. 

Duration The default duration for the timer in the selected “Units”. 

Units The units to use for the timer duration. 

Min The minimum value for the timer. Field personnel cannot adjust the 
timer to a duration that is shorter than this value. 

Max The maximum value for the timer. Field personnel cannot adjust 
the timer to a duration that is longer than this value. 

Submenu The submenu on the web-browser user interface where the timer 
will be shown. The application engineer may organize the timers 
into any logical grouping of menus that makes sense for their 
application. See section 3.7.4. 

Comment An optional descriptive comment. 

 
The duration of timers is field programmable on the web-browser user interface. Application 
engineering specifies the default timer value as well as a minimum time and a maximum time. 
Application engineering may also specify the submenu on the web-browser user interface where 
the timer will be listed. The configured Timer Name is displayed on the user interface. Field 
personnel may adjust the timer to any value between the specified minimum and maximum 
values. 
 

 

 

NOTE 
If the minimum and maximum values for the timer have been set to the 
same value, then the timer is not adjustable in the Web UI. 
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3.7.2.1 ADDING A TIMER 
To add a timer, select “Timers” on the left of the Logic Data editor screen, then click the “Add” 
icon on the toolbar.  The application engineer can name the timer, provide the name for the start 
logic state, provide the name for the expired logic state, configure the default duration, 
minimum, and maximum duration. The submenu of the web-browser user interface as well as a 
comment can also be provided. 

3.7.2.2 DELETING A TIMER 
To delete a timer, select “Timers” on the left of the Logic Data editor screen, select the variable 
in the table of variables on the right, then click the “Delete” icon in the toolbar. 

3.7.3 PROPERTIES 

Properties are field programmable options within the MCF, created by the application engineer. 
The user can set or clear a property from the web-browser user interface. Properties provide a 
logic state, which the MCF logic may use to enable or disable features.  
The following figure shows the Logic Data properties. 
 

 
Figure 3-7   Logic Data: Properties Screen 

 



MCF CONFIGURATION TOOL 

 

3-15 

Document No.: SIG-00-16-05   SEPTEMBER 2016 (REVISED APRIL 2021) 

Version: A.1 

Table 3-3 describes the options available for a property. 
 

Table 3-3   Logic Data: Properties Options 

Option Description 

Name The name of the property as displayed on the web-browser user 
interface. Field personnel will see this name when setting the 
property on the web-browser user interface. 

Init Value The initial value of the property when the MCF is first loaded into 
the WI. 

Submenu The submenu on the web-browser user interface where the 
property will be shown.  The application engineer may organize the 
properties into any logical grouping of menus that makes sense for 
their application. See section 3.7.4. 

Description A description of the property, which will be displayed to field 
personnel on the web-browser user interface. 

Comment An optional comment. 

 

3.7.3.1 ADDING A PROPERTY 
To add a property, select “Properties” on the left of the Logic Data editor screen, then click the 
“Add” icon on the toolbar. 

3.7.3.2 DELETING A PROPERTY 
To delete a property, select “Properties” on the left of the Logic Data editor screen, select the 
property in the table on the right, then click the “Delete” icon in the toolbar. 
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3.7.4 SUBMENUS 

Submenus allow the application engineer to organize field programmable timers and properties 
into a menu structure. The application engineer selects which submenu each timer and property 
should appear. 
Figure 3-8 shows the Logic Data editor screen for submenus.  
 

 
Figure 3-8   Logic Data: Submenus Screen 
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The web-browser user interface will show the timers and properties under selected submenu 
under Configuration  MCF Configuration  Logic Configuration as shown in Figure 3-9. 
 

 
Figure 3-9   Submenus Example on Web-Browser User Interface 

 

3.7.4.1 ADDING A SUBMENU 
To add a submenu, select “Submenus” on the left of the Logic Data editor screen, then click the 
“Add” icon on the toolbar 

3.7.4.2 DELETING A SUBMENU 
To delete a submenu, select “Submenus” on the left of the Logic Data editor screen, select the 
property in the table on the right, then click the “Delete” icon in the toolbar. 
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3.8 EDITING THE RELAY LOGIC 

The application engineer uses the Relay Logic Editor to write the MCF logic. The Relay Logic 
Editor consists of three parts: 

• the left side ‘Relay Equation’ list view 
• the ‘Logic Equation Text’ box on the bottom 
• the ‘Relay Circuit Diagram’ view in the center black area 

This is shown in the following figure. 
 

 
Figure 3-10   Relay Logic Editor Screen 

3.8.1 THE RELAY EQUATION LIST VIEW 

The ‘Relay Equation’ list view is used to navigate through the equation and/or to change the 
order of the equations. 

3.8.2 THE LOGIC EQUATION TEXT BOX 

The ‘Logic Equation Text’ box is used to enter logic for new equations or modify logic for 
existing equations. 
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3.8.3 THE RELAY CIRCUIT DIAGRAM VIEW 

The ‘Relay Circuit Diagram’ view displays a relay logic representation of the text equation. To 
open the Relay Logic Editor, press the ‘Relay Logic’ toolbar button. 

3.8.4 ADDING EQUATIONS 

To add equations to a project, press the ‘Add Equation’ toolbar button’ and type the equation in 
Boolean format in the text box. Press the ‘Save’ button to save the logic equation. After saving 
the logic equation, the relay logic version of the equation appears in the relay logic area of the 
editor and the name of the equation appears on the left side menu. 
The following logic operators can be used in the equations: 

• Boolean AND: ‘*’ 
• Boolean OR: ‘+’ 
• Boolean NOT: ‘~’ 
• Assignment: ‘=’ 
• End of Equation: ‘;’ 

Right-click an equation on the ‘Relay Equation’ list view to display the shortcut menu. Options 
are as follows: 

• View: displays the selected equation in the relay and text views 
• Insert Before: add a new equation and after saving the equation, it appears above the 

selected equation in the relay equation list view. 
• Insert After: add a new equation and after saving the equation, it appears below the 

selected equation in the relay equation list view. 
• Delete: remove the selected equation from the application logic. 
• Move Up: moves up the selected equation in the Relay Equation list view. 
• Move Down: moves down the selected equation in the Relay Equation list view. 
• Cut: cut the selected equation from the Relay Equation list view. 
• Paste: paste the previously cut equation into the selected position in the Equation list 

view. 
Equations can be cut and pasted from another source using the standard Ctrl-c and Ctrl-v. 
The ‘Font’ option is used to change font, style and size of the font used in the Relay Logic View. 
The ‘Resize’ option is used to zoom in and zoom out the Relay Logic View. 
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3.8.5 ADDING A BOOLEAN LOGIC STATE 

The user may add a new Boolean logic state from the Relay Logic editor without switching to 
the Logic Data editor first. Click the Add Boolean button on the toolbar to display the dialog box 
shown in Figure 3-11. 
 

 
Figure 3-11   Add Boolean Dialog Box 

 
Enter the name, initial state, and comments in this dialog box. This makes the logic state 
available to the relay logic and adds the logic state to the Boolean Variables shown in the Logic 
Data editor view. 
 

3.8.6 IMPORTING AND EXPORTING EQUATIONS 

All the relay logic equations can be exported to a file using the Export Equation button on the 
toolbar. Those equations can then be imported into another project by clicking the Import 
Equation button on the toolbar. 

3.8.6.1 EXPORTING EQUATIONS 
Click the Export Equation button to open a “Save As” dialog box. Name the file and save in any 
location on the computer file system. This saves a *.eq file, which includes all the equations in 
the current project. 
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3.8.6.2 IMPORTING EQUATIONS 
Click the Import Equation button to open a “File Open” dialog box. Select the *.eq file from the 
computer file system. This imports all the equations included in that *.eq file. 
If logic states do not exist yet in the project for the imported equations, the dialog box shown in 
Figure 3-12 will display. 
 

 
Figure 3-12   Import Equation Dialog Box 

 
Click the “Create Logic States and Save” button to create a Boolean variable logic state for the 
missing variable. 
The user can also leave the logic state undefined and define the logic state later by clicking the 
“Save without creating Logic States” button. The user can cancel the import by clicking the 
“Cancel” button. 
The selected action can be applied to the remaining equations in the *.eq file by checking the 
“Apply the action for remaining equations” option. 

3.8.6.3 EDITING *.EQ FILES 
For advanced users, the *.eq files are text files that users can manually edit. The file can  be 
edited with any text editor, such as Notepad. The user may change, add, or remove relay logic 
equations using the text editor and then later import them into the MCF Configuration Tool 
project. 
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3.8.7 FINDING RELAY CONTACT OR COIL 

Search for a relay contact or coil by clicking the “Find Relay” button on the toolbar. When the 
user clicks the “Find Relay” button, the dialog box shown in Figure 3-13 will display. 
 

 
Figure 3-13   Find Relay Dialog Box 

 
Type the name of the logic state in the “Find what” box and click find. All instances of the logic 
state will then be displayed in the dialog box. Select the equation of interest and click the “Go 
To” button to go to that equation in the relay logic editor. Then, click the “Close” button to close 
the dialog box. 
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3.8.8 CHECKING RELAY EQUATIONS 

The relay logic equations can be checked to ensure all the logic states are defined and the logic 
is consistent by clicking the “Check” button on the toolbar as shown in Figure 3-14. 
 

 
Figure 3-14   Check Button Options 

 
When clicking the “Check” button, the user can choose to check only the currently displayed 
equation or all the equations in the project. 
The “Current equation” option will check the syntax of the selected equation and it will also 
check if all logic states in the equation exist or not. The MCT will display an error to the user if a 
logic state does not exist. The “All equations” option has the same function for all equations in 
the project. 
 

3.8.9 REFRESHING THE RELAY LOGIC CIRCUIT DISPLAY 

The display may be refreshed by clicking the “Refresh” button on the toolbar. 
 

3.8.10 PRINTING RELAY LOGIC 

If the Relay Logic editor view is selected, the user may print the relay logic circuit diagrams by 
selecting the File > Print option from the menu or by clicking the Print button on the toolbar. 
Clicking the Print button displays a dialog box showing the progress of the print output. After the 
print output is created, the Print preview dialog box displays as shown in the following figure. 
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Figure 3-15   Print Preview Dialog Box 

 
From the print preview dialog box, the output can be viewed before printing and the output can 
be sent to a printer on the computer running the MCF Configuration Tool. 
To select the printer, click the “Printer Properties” button. This is the second button located on 
the print preview toolbar as shown in the above figure. Select the printer to send the output to, 
or choose to save the output as a PDF on the computer. After the printer properties have been 
set, click the “Print” button on the print preview toolbar, to print the file. 
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3.9 FINDING & REPLACING LOGIC STATES 

Use the Find & Replace option to search and replace logic states in the Logic Data Editor. 
 

 
 

1. Go to Edit > Replace 
2. Enter the text to be located in the “Find What” box. 
3. Enter the new text in the “Replace With” box. 
4. Select Find Next until the logic state to be updated is found. 
5. Select “Replace” to replace the text in the selected logic state. 
6. Select “Replace All’’ to update all logic state instances at once in the editor. 
7. Select “Close” to close the “Find & Replace” dialog box. 

  



MCF CONFIGURATION TOOL 

 

3-26 

Document No.: SIG-00-16-05   SEPTEMBER 2016 (REVISED APRIL 2021) 

Version: A.1 

 

3.10 COMPILING THE MODULE CONFIGURATION FILE 

The MCF Configuration Tool compiles the configuration settings and relay logic equations into 
the Module Configuration File (MCF). 
To compile the MCF, click the “Build” icon on the toolbar or select Project > Build MCF from the 
menu. 
After triggering the compilation process, the compile output window will output on the bottom of 
the application. The compile output window will show details about the compilation and if any 
errors are detected in the compilation process. The following figure shows the MCF 
Configuration Tool compile output window. 
 

 
Figure 3-16   Build Icon 
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After the compilation process completes, the MCF file can be found in the path shown in the 
status bar of the MCF Configuration Tool. The file name includes the project name, the MCF 
version (as set under Project > Project Properties), and the “MCF” file name extension. 
For the example shown in Figure 3-16 and with the MCF version set to 3, the resulting file name 
is: WI_WEI34222_TEST003.MCF.  
If there are any compilation errors, they will be shown in the Output Window. Table 3-4 
describes each possible error and how to fix it. 
 

Table 3-4   Compilation Errors 

Error Solution 

Duplicate internal state name: Internal State Change the logic state name to make it 
unique. 

Following logic states does not exist: 
GATESDOWNALL 
in equation: GATESDOWNALL = STARTUPTER 
* MTSSHLTHY * ((~GATETIP_EN * GD1 * GD2) 
+ (GATETIP_EN * GTIP1 * GTIP2)); 

Define the missing logic state. 

Logic State name can't be numeric. Change the logic state name to start with 
a letter. 

Error in converting equation: GFTSTOFF = 
~GFT_ST  (GFTSTOFF * ~GFTSTON) 

Correct equation syntax.  In this example 
either a ‘+’ or a ‘*’ is missing between 
“~GFT_ST” and the first parentheses. 

Error in GetTimerCardSectionElement section of 
xml document. 

Timer name can’t be numeric. Change 
the timer name to start with a letter. 

Error in creating properties of a card section.  Property name can’t be numeric. Change 
the property name to start with a letter. 

The 'normvalue' element is invalid - The value 
'FALSEx' is invalid according to its datatype 
'ui_enum_true_false' - The Enumeration 
constraint failed. 

Correct the normal value of the logic 
state. 
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3.11 DECOMPILING AN EXISTING MCF 

The MCF file contains all project files and information needed to edit the MCF in the MCF 
Configuration Tool. If the original folder and files from the MCF Configuration Tool are missing, 
they can be recreated from the MCF file by decompiling the MCF. 
To decompile the MCF, click the Project > Decompile MCF option from the menu as shown in 
Figure 3-17. 

 
Figure 3-17   Decompile MCF 

 
When selecting the Decompile MCF option, the currently open project will need to first be 
closed. The dialog box shown in Figure 3-18 will display. Select Yes to close the currently open 
project or select No to cancel the decompile process. 
 

 
Figure 3-18   Decompile Dialog Box 

 
Selecting Yes will display a standard File Open dialog box. Select the MCF file from the 
computer’s file system and click the Open button. This action will create a file in the workspace 
folder named from the selected MCF and will create all the necessary subfolders and data files. 
If there is already a folder in the workspace with that name, the MCF Configuration Tool will ask 
if you want to create a new folder as shown in Figure 3-19. 
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Figure 3-19   Folder Conflict Dialog Box 

 
Select Yes and the project name dialog box will display as shown in Figure 3-20. 
 

 
Figure 3-20   Project Name Dialog Box 

 
Enter the new project name and click OK to create the new project folder and corresponding 
files in the workspace folder. Details about the de-compilation will be displayed in the output 
window at the bottom of the application. 
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3.12 SETTING PROJECT PROPERTIES 

Set the version of the MCF and the Card Definition package for the MCF using the Project 
Properties dialog box shown in Figure 3-21. 
 

 
Figure 3-21   Project Properties Dialog Box 

 
The MCF version will be included in the file name of the compiled MCF when the MCF is built 
and will be shown on the WI when viewing the MCF version. 
The card definition package can be changed in the Project Properties. Typically, the default 
package shown does not need to be changed. For details on selecting the card definition see 
section 3.3. 
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3.13 SIMULATING THE MCF LOGIC 

The MCF Configuration Tool can simulate the operation of the MCF as it would execute when 
loaded in a WI. The simulator view can be opened by clicking the Simulate button on the 
toolbar. The Simulate view is shown in Figure 3-22. 
 

 
Figure 3-22   Simulate Screen 

3.13.1 LIST OF LOGIC STATES 

The MCF Configuration Tool shows the logic states in the bottom pane of the simulator view. 
The logic states can be filtered using the “Inputs”, “Outputs”, and “Internal Variables” 
checkboxes. The “Sort” checkbox will update the logic states list to show in alphabetical order. 
Logic states that are set (have a value of TRUE) are shown with a green background. Logic 
states that are clear (have a value of FALSE) have a black background. The currently selected 
logic state has a blue or white background. 



MCF CONFIGURATION TOOL 

 

3-32 

Document No.: SIG-00-16-05   SEPTEMBER 2016 (REVISED APRIL 2021) 

Version: A.1 

3.13.2 CHANGING A LOGIC STATE 

Change the value of a logic state on the displayed relay circuit diagram by right-clicking the 
contact in the diagram and selecting Toggle State, as shown in Figure 3-23. This will update the 
diagram to show the new state. The MCF Configuration Tool will execute the logic with the new 
state change and update all logic states accordingly to the defined relay logic equations. 
Changing a logic state does not advance timers. Timers must be advanced manually. See 
section 3.13.5 for information on running timers. 
The user may only toggle the state of contacts if they are not driven by another relay circuit in 
the logic. Right-click the contact and select “Show Logic” to go to the logic driving that contact to 
change the state. 

 
Figure 3-23   Toggle Logic State from Relay Circuit Diagram 

 
The user can also change the value of a logic state by right-clicking the logic state in the logic 
state list pane as shown in Figure 3-24. 
 

 
Figure 3-24   Changing Logic State 
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3.13.3 SELECTING THE RELAY LOGIC CIRCUIT TO VIEW 

There are multiple ways to select the relay circuit diagram to view on the relay circuit diagram 
area. The user can right-click a logic state in the list of logic states in the bottom pane and select 
“Show Logic” if that logic state is a relay coil. The user can select “Show Where Used” to see 
other relay circuits that use the coil and to find relay circuits that use a contact. The user can 
also right-click a contact in the currently shown relay circuit diagram and select “Show Logic” or 
“Show Where Used” to find other equations using the logic state. Logic states can be searched 
for by name in the “Search” box. 

3.13.4 CHANGING PROPERTIES  

The properties for the MCF can be changed in the “Properties” pane in the simulation view. 
Double-click the property to change the TRUE or FALSE value as shown in Figure 3-25. When 
the properties value is changed, the MCF Configuration Tool automatically executes the logic 
with that change and updates the displayed states on the relay circuit diagram and in the logic 
state view. 
 

 
Figure 3-25   Changing a Property 

 

3.13.5 RUNNING TIMERS 

Timers are manually expired by right-clicking the timer in the “List of Timers” pane and selecting 
“Expire Timer”. The MCF Configuration Tool will not let the user expire a timer that does not 
have the input circuit to the timer set (TRUE). 
The “Pause” button will stop the automatic execution of the logic when the user changes a logic 
state.  That enables the user to set multiple inputs states and have them all applied at once.  
The “Play/Resume” button start the execution of the logic after the logic states have been 
changed. 

3.13.6 REAL TIME FEEDBACK OF CHANGES 

The Real Time Feedback pane in the lower right corner shows the history of logic states 
changes during the simulation.  As the simulator executes the logic, the simulator updates this 
list of changes with the new values of logic states that changed. 
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3.13.7 RESETTING THE SIMULATOR 

The simulation can be reset to the initial state by clicking the Reset Simulator button as shown 
in Figure 3-26. 
 

 
Figure 3-26   Reset Simulator Button 

 
After clicking the button, the user is prompted to confirm they want to perform the reset. If 
confirmed, all logic states will be returned to their default initial values and the simulation can 
start again. 
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3.14 VIEWING MCF CONFIGURATION TOOL VERSION INFORMATION 

To view the version of the MCF Configuration Tool, click Help > About MCF Configuration Tool 
from the menu. 
The version dialog box also shows the version of the components used by the MCF 
Configuration Tool. This information may be copied and pasted when sending version 
information to Siemens Mobility, Inc by clicking the “Copy” button. The version dialog box is 
shown in Figure 3-27. 
 

 
Figure 3-27   About MCF Configuration Tool Dialog Box 
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CHAPTER 4 – FUNCTIONS, CONFIGURATION PARAMETERS, & 
LOGIC STATE DEFINITIONS 

An application engineer tailors the functionality of the WI by writing a Module Configuration File 
(MCF). The MCF includes configuration settings and the relay logic. The application engineer 
uses the MCF Configuration Tool (MCT) to create the MCF. The MCT presents screens to 
define the MCF configuration settings, configure timers and logic states, and write the logic 
using Boolean equations and relay logic diagrams. 
This document provides guidance regarding MCF content. This chapter provides a reference to 
the application engineer for all WI configuration settings and their purpose, and provides a 
reference to the application engineer for all WI logic states, which are available to the MCF 
logic. 

4.1 LOGGING 

The WI keeps three logs: the Event Log, the Diagnostic Log, and the Application Log. 
• The Event Log contains entries showing external crossing events detected by the WI. 

The Event Log is useful to investigate crossing operation. 
• The Diagnostic Log contains entries showing internal WI operations and data. The 

Diagnostic Log is useful to troubleshoot the WI itself. 
• The Application Log contains only the Event Log entries created by the MCF. The 

Application Log is useful for troubleshooting the MCF logic used with a particular 
installation. 

The WI always logs entries in chronological order. The time stamp may change forward or 
backward as the user changes the time; however, events are always added to the log in the 
order they occurred. 
The WI logs have a circular structure. When a WI log is full and a new entry is added to the log, 
the new entry overwrites the oldest entry. 
 

4.1.1 EVENT LOG ENTRIES 

The event log will hold up to 172,800 entries. The following is an example event log entry: 
 

095D  11-Apr-2016 13:26:15.30  AI     Power In 12.0 V 

 
Table 4-1 describes the fields contained in each event log entry. 
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Table 4-1   Event Log Entry Fields 

Example Text Field Description 

095D CRC When downloading an event report, each line of the 
report includes a CRC. The CRC is generated using 
the data for this entry and seeded using data from 
previous entries. The user can verify a malicious 
person has not changed the report text or re-ordered 
the entries by using a verification tool on a PC. 

11-Apr-2016 13:26:15.30 Time stamp The date and time the entry was added to the log, to 
the hundredth of a second. 

AI Entry Type The entry type mnemonic of the log entry. AI is for 
analog input (a.k.a. Battery Input). See Table 4-4 for 
entry type mnemonics. 

Power In 12.0 V Entry Text The text of the entry detailing the event. This 
example shows the Power In input changed to 12.0V. 

 

4.1.2 DIAGNOSTIC LOG ENTRIES 

The diagnostic log will hold up to 172,800 entries. The diagnostic log entries contain the same 
data as the event log entries with the addition of the “Verbosity” field. The following is an 
example of a Diagnostic Log entry. 
 

DA75  24-Mar-2016 13:59:27.33  INFO  TMON   Thread Registered:wimag id:10 

 
Table 4-2 describes the fields in each diagnostic log entry.  
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Table 4-2   Diagnostic Log Entry Fields 

Example Text Field Description 

DA75 CRC When downloading a diagnostic log, each line of the 
report includes a CRC. The CRC is generated using 
the data for this entry and seeded using data from 
previous entries. The user can verify a malicious 
person has not changed the report text or re-ordered 
the entries by using a verification tool on a PC. 

24-Mar-2016 13:59:27.33 Time stamp The date and time the entry was added to the log, to 
the hundredth of a second. 

INFO Verbosity 
Level 

The verbosity level of this entry, which is 
“Information”. See Table 4-3 for a description of 
each verbosity level. 

TMON Entry Type The entry type mnemonic shown the type of event 
entry. See Table 4-4 for entry type mnemonics. 

Thread Registered: 
wimag id:10 

Entry Text The text of the entry detailing the event. 

 
Each entry has a verbosity level associated with it. The diagnostic logging function also has a 
logging verbosity level. The WI will only add entries with the same verbosity level or lower to the 
diagnostic log. The user may turn the verbosity up or down to control how much information is in 
the diagnostic log. If turned all the way up, the diagnostic log may include a lot of information in 
a short amount of time, limiting the duration of time the log covers. If turned all the way down, 
the diagnostic log may cover a long duration of time but not include much detail. 
Table 4-3 lists the verbosity levels and their meanings. 
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Table 4-3   Diagnostic Log Verbosity Levels 

Verbosity Level Meaning 

Basic Basic level entries are always included in the diagnostic log and contain 
standard information about the operation of the system. 

Error Critical system errors such as hardware failures that the system cannot 
recover from. 

Warning Unexpected events, which could indicate a problem, but the system can 
continue operating under this condition. 

Info Potentially useful information. These entries do not represent a failure or fault 
in the system. 

Debug Information that may be needed to understand the internal operation for a 
software or hardware engineer. This information is not normally useful for 
anyone else. 

 
Field personnel can change the diagnostic log verbosity level using the web browser user 
interface. The verbosity level defaults to “Info”, which means the diagnostic log contains entries 
at verbosity level Basic, Error, Warning, and Info. 

4.1.3 APPLICATION LOG ENTRIES  

The Application Log is a filtered version of the Event Log and each entry has the same 
information. The Application Log includes only the entries the MCF logic adds to the event log 
using the “alarms” capability described in section 4.10. 
 
The following is an example of an Application log entry. 
 

A0D7  02-Dec-2019 11:52:38.45  APPL   iLOD-2 HEALTH BAD 

 

4.1.4 ENTRY TYPE MNEMONICS 

Table 4-4 lists the log entry type mnemonics and their meaning. 
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Table 4-4   Log Entry Type Mnemonics 

Mnemonic Meaning 

AC, ACPW Entries relating to the AC power input and AC power control relay. 

AI Entries for battery inputs (a.k.a. analog inputs). 
AIPF ATCS/IP Field protocol logging entries 
AIPO ATCS/IP Office protocol logging entries 
APPL Messages added by the MCF as defined in the application logic. 
CFG Entries concerning configuration data changes. 
COMM Communications-related log entries 
DBUG Debugging entries 
DI Digital inputs  
ECHL Echelon device communication entries 
ETH Ethernet port 
EXEC General events logged by the executive software 
GCP GCP 4000, GCP 5000, and GCP 3000+ interface entries 
GCP3 Legacy GCP 3000 interface entries 
GFT Ground fault test entries 
GNFA ATCS/Genisys Field protocol logging entries 
iLOD iLOD module logging entries 
INIT Entries relating to system initialization. 
INSP Inspection entries 
L7 Message tracing entries for ATCS layer 7 messages 
MCFE MCF logic engine entries 
MOSM Maintainer on Site mode 
MTSS Mini-trackside sensor entries 
PATH Office primary and backup failover entries 
PBTN On-site personnel button 
PMGR Port manager 
RLY Relay outputs 
RTE Message tracing entries for routing of ATCS layer 3 packets 
SDPM Siemens digitalization protocol entries 
SER Serial port 
SW Software upgrade entries 
SYS General system entries 
TIME Date/time changes and time related entries 
TMON Internal task monitor entries 
UI Web-browser user interface entries 
UUDC Uploading/downloading configuration data file entries 
WAMS Wayside Alarm Management System protocol entries 
WMAG Wireless Magnetometer entries 
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4.1.5 LOG DURATION 

When the log is full, the WI overwrites the oldest entry with the new entry. By default, the WI 
uses the full storage capacity of the log (178,000 entries). The application engineer may choose 
to only keep a specific duration of log data instead of the full storage capacity.  For example, the 
customer may want to keep only the last 90 days of log entries. If the application engineer sets 
a Log Duration Value in the MCF, the WI will delete entries older than the Log Duration Value, 
each day at midnight. 
The application engineer sets the Log Duration Value when creating the MCF. Field personnel 
may not change the Log Duration Value and it is not visible on the WebUI.   
See section 4.3 for how to set the Log Duration Value in the MCF. 

4.2 CONFIGURATION STORAGE 

The WI stores all system configuration settings on the ECD. The activity LED on the ECD will 
blink when the WI accesses the ECD. Field personnel may replace a WI with a new unit, without 
reprogramming the configuration parameters again. 
The WI uses two types of configuration parameters: MCF parameters and per-unit parameters. 

4.2.1 MCF PARAMETERS   

The compiled MCF includes the values of all MCF parameters. The application engineer defines 
the values of these settings when writing the MCF. After field personnel load the MCF into the 
WI, field personnel can change many of the MCF parameters using the web-browser user 
interface. Not all MCF parameters are field programmable. Subsequent sections of this chapter 
identify the MCF parameters that are changeable on the web-browser user interface.   

4.2.2 PER-UNIT PARAMETERS 

The per-unit parameters are specific to each installation. The values of the per-unit parameters 
are not included in the compiled MCF. Field personnel must set the value of per-unit parameters 
while on-site by using the web-browser user interface. Examples of per-unit parameters include 
the Site Name, Mile Post, DOT Number, networking settings, and protocol options. The per-unit 
parameters are described in Chapter 5. 

4.3 GENERAL CONFIGURATION 

The WI Editor of the MCF Configuration Tool provides a screen to edit general parameters of 
the MCF. Figure 4-1 shows the MCF Configuration Tool screen for the general configuration 
parameters and logic states. 
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Figure 4-1   General Configuration 

 
Table 4-5 describes the general configuration parameters. 
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Table 4-5   General Configuration Parameters 

Parameter  Range Default Web UI 
Editable 

Description 

Log Duration 
Value 

Full,  
30 days,  
60 days,  
90 days,  
120 days,  
180 days 

Full No Sets how the WI will delete old log 
entries. See section 4.1.5 for how the WI 
uses the Log Duration Value. 

Maintainer On 
Site Time 

10 minutes 
to 180 
minutes 

30 minutes Yes This value determines the length of time 
the WI will remain in Maintainer On Site 
mode when field personnel press the On-
Site Personnel button. See section 4.15 
for a description of maintainer on site 
mode. 

 
Table 4-6 describes the general logic states available to the MCF logic. 
 

Table 4-6   General Logic States 

Logic State Label Functional Description 

Input Logic States 

Maintainer On Site 

Set when a field user presses the on-site personnel push button on the 
front panel of the WI and the WI enters maintainer on site mode. 
Cleared when the Maintainer On Site Timer expires. 
See section 4.15 for a description of maintainer on site mode. 

User Alarm Ack 

Set when a user selects the “Clear Alarm” button from the web-browser 
user interface. The logic state stays set for one logic cycle and 
automatically clears at the end of logic execution. The MCF logic can use 
this logic state to clear alarms that do not auto clear or to ensure Field 
Personnel have seen an alarm before it is cleared. 

ECD Health IP 
Clear while the ECD is considered healthy. Set when the ECD health check 
fails. The MCF logic can use this logic state to generate an ECD failure 
alarm and display an LED status to inform field personnel of the failure. 

Output Logic States 

Beeper Control 
When set by the MCF logic, the WI will turn on the beeper. The beeper will 
stay on while the logic state is set. The WI will turn off the beeper when the 
MCF logic clears this logic state. 
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4.4 AC POWER MONITOR AND AC POWER CONTROL 

The AC Power Input works the same as a standard discrete input (see section 4.6) except the 
default de-bounces and toggle period are set to accommodate AC power. Internally, the 
hardware half-wave rectifies the AC signal, which means half the energy is visible to the 
software sampling. To improve AC detection, the default ON de-bounce is 0ms. The software 
will declare the AC power as ON if any AC energy is present. The default OFF de-bounce is 
1000ms. The software will not declare the AC power as OFF until it has been off for a full 
second. There is no need to detect “TOGGLING” for AC power; therefore, toggle detection is 
not enabled. The application engineer may change the default de-bounce settings when 
creating the MCF and field personnel may change them using the web-browser user interface. 
The AC Power Control relay works the same as the general-purpose relay outputs except the 
back contact is not available for wiring. There is no need to toggle the AC power so automatic 
toggling of the AC power control relay is not available. 
The application engineer configures the settings for the AC Power Monitor input and the AC 
Power Control output on the screen shown in Figure 4-2. 
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Figure 4-2   AC Power 

 
For a description of each AC Power Monitor and AC Power Control parameter, see Table 4-7. 
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Table 4-7   AC Power Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

AC Pwr Monitor 
Name 

20 characters ACPWR Yes, 
unless 
Locked 

Name used when logging state changes 
in the event log and included on the 
configuration report. 

AC Pwr Monitor 
Locked 

No, 
Yes 

No No If set to Yes, UI will not allow Field 
Personnel to change the channel name 
and state names of this channel. 

AC Pwr Monitor 
On Name 

On state 
name list 

On Yes, 
unless 
Locked 

Name used for the ON state when 
logging state changes in the event log. 
Name is selected from a user definable 
list of possible ON state names. 

AC Pwr Monitor 
Off Name 

Off state 
name list 

Off Yes, 
unless 
Locked 

Name used for the OFF state when 
logging changes in the event log. Name 
is selected from a user definable list of 
possible OFF state names. 

AC Pwr Monitor 
Off Debounce 

0 to 60,000 
ms 

1000 Yes Debounce timer to declare the input OFF. 
If the input is ON, the WI must not detect 
energy on the input for this period of time, 
continuously, before declaring it OFF. 

AC Pwr Monitor 
On Debounce 

0 to 60,000 
ms 

0 Yes Debounce timer to declare the input ON.  
If the input is OFF, the WI must detect 
energy on the input for this period of time, 
continuously, before declaring it ON. 

AC Pwr Control 
Name 

20 characters ACRLY Yes, 
unless 
Locked 

Name used when logging commanded 
state change in the event log and 
included on the configuration report. 

AC Pwr Control 
Locked 

Yes or No No No If set to Yes, UI will not allow  Field 
Personnel to change the channel name 
and state names of this channel 

 
The application engineer enters variable names for the AC Power Monitor and AC Power 
Control logic states on the screen shown in Figure 4-2. The application engineer uses the 
variable names in the MCF logic. For a description of the AC Power Monitor and AC Power 
Control logic states, see Table 4-8. 
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Table 4-8   AC Power Logic States 

 
  

Logic State Label Functional Description 

Input Logic States 

AC Power Monitor Set when the AC Power Monitor input is considered ON and clear when 
considered OFF. 

Output Logic States 

AC Power Control The MCF logic may set this logic state to turn ON the AC Power Control 
relay output (energize the relay’s coil to close the contacts).  Typically, 
this is used in the Standby Power test to turn off AC power to the 
location. 
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4.5 STATE NAMES 

State names specify the text to use when logging the change to inputs or outputs. If an input 
changes to the energized state, the WI will log the selected On Name for that input. When it 
changes to the de-energized state, the WI will log the selected Off Name for that input. 
Figure 4-3 shows the MCF Configuration Tool screen to configure the list of state names. After 
the state names are entered, they will be available in the list of state names for each of 
configurable functions, such as Digital Input, GFT Inputs, and Relay Outputs. 
 

 
Figure 4-3   State Names 
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Table 4-9   State Names Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

On Names 1 to 12 
Characters 

Not Used Yes The list of on state names, which will be 
available to choose from when 
configuring the “On Names” for inputs 
and outputs. 

Off Names 1 to 12 
Characters 

Not Used Yes The list of off state names, which will be 
available to choose from when 
configuring the “Off Names” for inputs 
and outputs. 

Toggle Names 1 to 12 
Characters 

Not Used Yes The list of toggle names, which will be 
available to choose from when 
configuring the “Toggle Names” for 
inputs and outputs. 

Battery Names 1 to 12 
Characters 

Not Used Yes The list of battery names, which will be 
available to choose from when 
configuring the “Battery Names” for GFT 
input channels. 
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4.6 DIGITAL INPUTS 

The WI monitors the crossing using digital inputs. The application engineer can set each digital 
input to operate in the following modes: Discrete, GFT, MTSS, or Not Used. The mode is 
selected in the MCF Configuration Tool on the WI Editor page by setting the Channel Type field 
as shown in the following figure. 
 

 
Figure 4-4   Digital Inputs Screen showing Channel Type 
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4.6.1 DISCRETE INPUTS 

The WI declares discrete digital inputs to be in one of the following states: OFF, ON, or 
TOGGLING. When the WI detects a state change, the WI adds an entry to the event log. The 
log entry includes the name of the input and a name for the state. For example, an input named 
“XR” with an OFF state name of “DOWN” and an ON state name of “UP would be logged as 
“XR DOWN” when the input turns off. The software would log “XR UP” when the input turned 
back on. The following is an example from an event report: 
 

B85F  07-Apr-2016 13:42:50.35  DI    XR UP 

 
The executive software determines the input’s state by sampling the input hardware. The inputs 
are de-bounced to prevent logging state changes caused by noise and to prevent MCF logic 
from acting on transient states. Before the software declares the input is ON, it must have 
consecutive energized samples for the on de-bounce time. 
The software implements toggle detection to prevent filling up the log if external relays or 
equipment fails. When the software detects the input is toggling, it will log one single event 
rather than a long sequence of ON/OFF entries. If the software sees four or more changes on 
the input within the toggle period, it will declare the input as toggling. 
The input state is available to the MCF logic. 
The application engineer configures the name of the discrete input channel, the state names, 
and the debounce settings through the WI Editor on the MCF Configuration Tool as shown in 
the following figure. 
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Figure 4-5   Discrete Input Configuration and Logic States 
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The following table provides a description for each discrete input parameter. 

Table 4-10   Discrete Input Configuration Parameters 

Parameter Range Default Web UI 
Editable 

Description 

Name 20 characters DIxx Yes, 
unless 
Locked 

Name used when logging state 
changes in the event log and 
included on the configuration report. 

Channel Type Discrete Input Discrete 
Input 

Yes, 
unless 
Locked 

Selects the type of function the input 
used for. Must select “Discrete 
Input” for discrete inputs. 

Locked Yes or No No No If set to Yes, the WebUI will not 
allow  Field Personnel to change the 
channel name and state names of 
this channel. 

On Name On state name 
list 

On Yes, 
unless 
Locked 

Name used for the ON state when 
logging state changes in the event 
log. Name is selected from a user 
definable list of possible ON state 
names. 

Off Name Off state name 
list 

Off Yes, 
unless 
Locked 

Name used for the OFF state when 
logging changes in the event log. 
Name is selected from a user 
definable list of possible OFF state 
names. 

Toggle Name Toggle state 
name list 

Toggle Yes, 
unless 
Locked 

Name used for the TOGGLE state 
when logging changes in the event 
log. Name is selected from a user 
definable list of possible TOGGLE 
state names. 

Off Debounce 0 to 60,000 ms 100 Yes Debounce timer to declare the input 
OFF. If the input is ON, the WI must 
not detect energy on the input for 
this period of time, continuously, 
before declaring it OFF. 

On Debounce 0 to 60,000 ms 100 Yes Debounce timer to declare the input 
ON. If the input is OFF, the WI must 
detect energy on the input for this 
period of time, continuously, before 
declaring it ON. 
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The application engineer enters variable names for the discrete input logic states on the screen 
shown in Figure 4-5. The application engineer uses the logic state variable names in the relay 
logic. For a description of each discrete input logic state, see Table 4-11. 
 

 

 

NOTE 
It is not necessary to use both the “On State” and the “Toggle State” logic 
states. 
The “On State” logic state may be either set or clear and is not relevant if 
the “Toggle State” logic state is set. 

 
Table 4-11   Digital Input Logic States 

 
  

Logic State Label Functional Description 

Input Logic States 

On State Set when the WI declares a digital input is on. 

Toggle State Set when the WI declares a digital input is TOGGLING. 

Configuration Logic States 

Is Discrete Input Set if the digital input channel is configured as a Discrete Input. 

Is GFT Set if the digital input channel is configured as a GFT input. 

Is MTSS Set if the digital input channel is configured as an MTSS input. 
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4.6.2 GFT INPUTS 

The WI can process the pulsed data signal used by the A80297 GFT and the A81010 GFT2. 
There are 4 bits of data sent by the GFT: GFT Health (Good or Bad), GFT Mode (Normal or 
Test), Battery 1 Status (Fault/No Fault), and Battery 2 Status (Fault/No Fault). The WI also 
detects the “stuck low” and “stuck high” line status errors. The WI logs changes to each GFT 
status bit and the line status. The status bits and the line status are available to the MCF logic. 
The application engineer configures the name of the GFT channel and the names of each 
battery bank monitored by the GFT on the screen shown in Figure 4-6. The WI will use the 
configured names in the logged events for the connected GFT. 
 

 
Figure 4-6   GFT Inputs 

 
Table 4-12 describes each GFT input configuration parameter. 
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Table 4-12   GFT Configuration Parameters 

Parameter Range Default Web UI 
Editable 

Description 

Name 20 
characters 

DIxx Yes, unless 
Locked 

Name used when logging state 
changes in the event log and 
included on the configuration report. 

Channel Type GFT Discrete 
Input 

Yes, unless 
Locked 

Selects the type of function the input 
used for. Must be selected as “GFT” 
for GFT inputs. 

Locked Yes or No No No If set to Yes, the WebUI will not 
allow Field Personnel to change the 
channel name and state names of 
this channel. 

Battery 1 
Name 

On state 
name list 

On Yes, unless 
Locked 

Name used for the logging battery 
bank fault statuses for the battery 1 
input of the connected GFT (refer to 
section 4.5). 

Battery 2 
Name 

Off state 
name list 

Off Yes, unless 
Locked 

Name used for the logging battery 
bank fault statuses for the battery 2 
input of the connected GFT (refer to 
section 4.5). 

 
The application engineer enters variable names for the GFT logic states on the screen shown in 
Figure 4-6: GFT Inputs. The application engineer uses the variable names in the relay logic. For 
a description of each GFT logic state, see Table 4-13. 
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Table 4-13   GFT Logic States 

 

4.6.3 MTSS INPUTS 

The WI can process the pulsed data signal used by the MTSS. The MTSS sends 5 bits of data: 
Gate Up, Gate Down, Gate Level, Bell Power, and Bell Audio. Each data bit can be on or off. 
The WI logs changes to the MTSS status in the event log using fixed names for each status bit. 
The WI can also detect the “stuck low” and “stuck high” line status errors. The WI will log 
changes to the line status. 
The status bits and the line status are available to the MCF logic. 
The application engineer configures the name of the MTSS channel on the screen shown in 
Figure 4-7. The WI uses the configured name in the logged events for the connected MTSS. 
 

Logic State Label Functional Description 

Input Logic States 

Battery 1 Fault Set if the GFT is reporting a ground fault on battery input 1. 

Battery 2 Fault Set if the GFT is reporting a ground fault on battery input 2. 

GFT Health Set if the GFT is not healthy. Clear if the GFT is healthy. 

GFT Mode Set if the GFT is in test mode. Clear if it is in normal mode. 

Line Stuck High Set if the GFT data signal is stuck high (energized continuously). 

Line Stuck Low Set if the GFT data signal is stuck low (no data signal present). 

Configuration Logic States 

Is Discrete Input Set if the digital input channel is configured as a Discrete Input. 

Is GFT Set if the digital input channel is configured as a GFT input. 

Is MTSS Set if the digital input channel is configured as an MTSS input. 
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Figure 4-7   MTSS Inputs 

 
Table 4-14   MTSS Configuration Parameters 

Parameter Range Default Web UI 
Editable 

Description 

Name 20 characters DIxx Yes, 
unless 
Locked 

Name used when logging state 
changes in the event log and 
included on the configuration 
report. 

Channel Type MTSS Discrete 
Input 

Yes, 
unless 
Locked 

Selects the type of function the 
input used for. Must be set to 
“MTSS” for MTSS inputs. 

Locked Yes or No No No If set to Yes, the WebUI will not 
allow field personnel to change 
the channel name. 
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The application engineer enters variable names for the MTSS logic states on the screen shown 
in Figure 4-7. The application engineer uses the variable names in the MCF logic. Table 4-15 
describes the available MTSS logic states. 
 

Table 4-15   MTSS Logic States 

 

4.6.4 NOT USED INPUTS 

In some cases, the user may wish to ignore inputs without removing external wiring connected 
to that input. The user may set the Channel Type for an input to “Not Used” and the WI will 
ignore the input. 
  

Logic State Label Functional Description 

Input Logic States 

Gate Up Set if the MTSS is reporting the monitored Gate Up input is on 

Gate Down Set if the MTSS is reporting the monitored Gate Down input is on 

Gate Tip Set if the MTSS is reporting the monitored Gate Tip input is on (gate is 
level) 

Bell Power Set if the MTSS is reporting the monitored Bell Power input is on (bell is 
powered) 

Bell Audio Set if the MTSS is reporting the monitored Bell Audio is on (bell is ringing) 

Line Stuck High Set if the MTSS data signal is stuck high (energized continuously). 

Line Stuck Low Set if the MTSS data signal is stuck low (no data signal present). 

Configuration Logic States 

Is Discrete Input Set if the digital input channel is configured as a Discrete Input. 

Is GFT Set if the digital input channel is configured as a GFT input. 

Is MTSS Set if the digital input channel is configured as an MTSS input. 
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4.7 ANALOG INPUTS 

The WI monitors battery banks at the crossing using the analog inputs. The executive software 
measures the voltage on the input by sampling the input at a user-configurable sample period. 
After sampling, the software averages the last user-configurable samples to determine the 
voltage. If the resulting voltage differs from the last logged voltage by a user-configurable 
resolution setting (or greater), the executive software logs a voltage change. The log entry 
includes the user-configured name of the battery bank and the voltage to the tenth of a volt (for 
example, OB 13.8V). 
The software can compare the voltage to up to 4 voltage threshold values. If the voltage is 
greater than or equal to the threshold value, the software sets an MCF logic state.  The MCF 
logic can use logic state for inspection or alarm logic. 
The application engineer configures the settings for the analog inputs on the MCT screen shown 
in Figure 4-8. 
 

 
Figure 4-8   Analog Inputs 
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For a description of each analog input configuration parameter, see Table 4-16. 
 

Table 4-16   Analog Input Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

Name 20 characters BATTx Yes, 
unless 
Locked 

Name used when logging state 
changes in the event log and included 
on the configuration report. 

Locked Yes or No No No If set to Yes, UI will not allow  Field 
Personnel to change the channel 
name and state names of this channel 

Resolution 0.1V to 36.0V 0.5V Yes Required change in voltage before the 
executive will log an entry. 

Sample 
Period 

100ms to 
60,000ms 

100ms Yes How often the executive will sample 
the input voltage. 

Average 
Count 

1 to 32 10 Yes The number of consecutive samples 
the executive will average together to 
determine the input’s voltage. 

Voltage 
Threshold 1 

0V to 36V 0V Yes If the last logged voltage is greater 
than or equal to this value, the 
executive will set the “Above 
Threshold 1” logic state for this battery 
channel. 

Voltage 
Threshold 2 

0V to 36V 0V Yes If the last logged voltage is greater 
than or equal to this value, the 
executive will set the “Above 
Threshold 2” logic state for this battery 
channel. 

Voltage 
Threshold 3 

0V to 36V 0V Yes If the last logged voltage is greater 
than or equal to this value, the 
executive will set the “Above 
Threshold 3” logic state for this battery 
channel. 

Voltage 
Threshold 4 

0V to 36V 0V Yes If the last logged voltage is greater 
than or equal to this value, the 
executive will set the “Above 
Threshold 4” logic state for this battery 
channel. 
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The application engineer enters variable names for the analog input logic states on the screen 
shown in Figure 4-7. The application engineer uses the variable names in the MCF logic. For a 
description of each analog input logic state, see Table 4-17. 
 

Table 4-17   Analog Input Logic States 

 

4.8 RELAY OUTPUTS 

The WI sets the relay outputs to states as commanded by MCF logic. Each relay output has a 
channel name, OFF name, ON name and TOGGLE name. When the MCF logic commands 
relay outputs to change state, the executive software adds an entry to the event log showing the 
channel name and newly commanded state (e.g. TLITE FLASH). 
The executive software automatically toggles the relay output at a user-programmable toggle 
rate and duty cycle when the MCF logic commands the relay output to the TOGGLE state. The 
application engineer does not need to write MCF timer logic to turn the relay off and on. 
The application engineer configures the settings for a relay output on the MCT screen shown in 
Figure 4-9: Relay Outputs. 

Logic State Label Functional Description 

Input Logic States 

Above Threshold1 State Set if the last logged voltage on the analog input channel is greater 
than or equal to the configured Voltage Threshold 1. 

Above Threshold2 State Set if the last logged voltage on the analog input channel is greater 
than or equal to the configured Voltage Threshold 2. 

Above Threshold3 State Set if the last logged voltage on the analog input channel is greater 
than or equal to the configured Voltage Threshold 3. 

Above Threshold4 State Set if the last logged voltage on the analog input channel is greater 
than or equal to the configured Voltage Threshold 4. 
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Figure 4-9   Relay Outputs 

 
For a description of each relay output configuration parameter, see Table 4-18. 
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Table 4-18   Relay Output Configuration Parameters 

Parameter 
Name Range Default Web UI 

Editable Description 

Name 20 characters RLYx 
Yes, 
unless 
Locked 

Name used when logging state 
changes in the event log and 
included on the configuration 
report. 

Locked Yes or No No No 

If set to Yes, UI will not allow  Field 
Personnel to change the channel 
name and state names of this 
channel 

Toggle Period 100ms to 
60,000ms 1000ms Yes If commanded to toggle, this is the 

period of time for each toggle cycle. 

Duty Cycle 5% to 95% 50% Yes 
If commanded to toggle, the 
percentage of the toggle cycle for 
the relay output to be ON. 

On Name On state name 
list On 

Yes, 
unless 
Locked 

Name used for the ON state when 
logging state changes in the event 
log. Name is selected from a user 
definable list of possible ON state 
names. 

Off Name Off state name 
list Off 

Yes, 
unless 
Locked 

Name used for the OFF state when 
logging changes in the event log. 
Name is selected from a user 
definable list of possible OFF state 
names. 

Toggle Name Toggle state 
name list Toggle 

Yes, 
unless 
Locked 

Name used for the TOGGLE state 
when logging changes in the event 
log. Name is selected from a user 
definable list of possible TOGGLE 
state names. 

 
The application engineer enters variable names for the relay output logic states on the screen 
shown in Figure 4-9. The application engineer uses the variable names in the MCF logic. For a 
description of each relay output logic state, see Table 4-19. 
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Table 4-19   Relay Output Logic States 

 

4.9 APPLICATION LEDS 

The MCF logic controls 8 general purpose Application LEDs. The application engineer may use 
the LEDs for any application specific indication. LED state changes are not logged. However, 
the LEDs are named for convenient reference when viewing status on the web browser user 
interface. The MCF logic may command the LEDs to OFF, ON, or TOGGLE. In the TOGGLE 
state, the executive software will automatically toggle the LED without needing timer logic in the 
MCF. The flash rate is fixed at a 2 second period and 50% duty cycle (LED is on for 1 second, 
off for 1 second). The application engineer configures the name of an Application LED on the 
MCT screen shown in Figure 4-10. 
 
 

Logic State Label Functional Description 

Output Logic States 

On State If set, the executive will turn ON the relay output channel. 

Toggle State 
If set, the executive will toggle the relay output at the configured toggle 
period and duty cycle. The exec will ignore the On State logic state if this 
logic state is set. 
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Figure 4-10   Application LEDs 

 
Table 4-20   Application LED Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

Name 20 characters LEDx No LED state changes are not logged. The 
channel name is provided only to identify 
the function of the LED in configuration 
reports and UI screens. 

The application engineer enters variable names for the Application LED logic states on the 
screen shown in Figure 4-10. The application engineer uses the variable names in the relay 
logic.  For a description of the Application LED logic states, see Table 4-21. 
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Table 4-21   LED Logic States 

 

4.10 APPLICATION MESSAGES AND ALARMS 

The application engineer may create messages, which can be added to the event log by MCF 
logic. The WI may optionally send the message to the office as a traditional WAMS alarm or as 
an alarm transmitted using the Siemens digitalization protocol through an ITCM system. 
The WI considers each application message to be either “set” or “clear”. The “set” or “clear” 
state is commanded by the MCF logic. 
When the MCF logic sets the application message status, the executive software adds the “Set 
Text” into the event log as an “APPL” event type. The Set Text may include a data value (for 
example, a battery voltage). If a transmission method is enabled, the executive software will 
also send the message to the office, including the configured “Set Code”. 
When the MCF logic clears the application message status, the executive software adds the 
“Clear Text” into the event log as an “APPL” event type. The Clear Text may include a data 
value. If a transmission method is enabled, the executive software will also send the message to 
the office, including the configured “Clear Code”. 
Some alarms do not have a corresponding clear. In that case, the MCF may leave the “Clear 
Text” blank and the executive software will ignore the application message when the MCF 
clears the status. The “set” state can also be ignored if the Set Text is blank. 
The application engineer configures the settings for Application Messages and Alarms on the 
screen shown in Figure 4-11. 

Logic State Label Functional Description 

Output Logic States 

On State If set by the MCF logic, the WI will turn on the LED. 

Toggle State 
If set by the MCF logic, the WI will toggle the LED (the LED flashes). The 
WI will ignore the On State logic state if the MCF logic sets this logic 
state. 
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Figure 4-11   Application Message and Alarms 

 
For a description of each Alarm configuration parameter, see Table 4-22. 
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Table 4-22   Alarm Configuration Parameters 

Parameter 
Name Range Default Web UI 

Editable Description 

Log Yes or No Yes No 

If yes, when the MCF logic sets the 
alarm’s logic state and if the Set Text is 
not blank, the executive will log the Set 
Text into the event log. When the MCF 
logic clears the alarm’s logic state and if 
the Clear Text is not blank, the executive 
will log the Clear Text into the event log. 

Send via ITCM Yes or No No No 

If yes, when the MCF logic sets the 
alarm’s logic state and if the Set Text is 
not blank, the executive will send a 
message to the office over the ITCM 
system using the Siemens digitalization 
protocol. The message includes the Set 
Text, Set Code, and Set Value.   
When the MCF logic clears the alarm’s 
logic state and if the Clear Text is not 
blank, the executive will send a message 
to the office over the ITCM system. The 
message includes the Clear Text, Clear 
Code, and Clear Value. 

Send to 
WAMS Yes or No No No 

If yes, when the MCF logic sets the 
alarm’s logic state and if the Set Text is 
not blank, the executive will send a 
message to the office over using the 
Siemens WAMS protocol. The message 
includes the Set Text, Set Code, and Set 
Value. 
When the MCF logic clears the alarm’s 
logic state and if the Clear Text is not 
blank, the executive will send a message 
to the office using the Siemens WAMS 
protocol. The message includes the Clear 
Text, Clear Code, and Clear Value. 

Set Text 64 characters <blank> No Text to include in log entries and alarm 
messages when the alarm is set. 

Set Code 0 to 255 0 No The code to use for this alarm in alarm 
messages when the alarm status is set. 
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Parameter 
Name Range Default Web UI 

Editable Description 

Set Value 
Type 

None, Battery Input 
Voltage, Timer, 
Digital Input, Relay 
Output, Logic Bit 

None No The value to include in the log entry or 
alarm message when the alarm is set. 

Set Value 
Channel 0 to 4000 0 No 

The channel that determines where the 
executive will ready the Set Value from 
according to the Set Value Type. The 
“channel” corresponds to the type of value 
that is being included in the alarm. If the 
MCF is sending a “low battery” alarm and 
the “Set Value Type” is “Battery Input 
Voltage”, then the “Set Value Channel” 
would be the battery input channel 
number to read the voltage from when the 
alarm is created. If the “Set Value Type” is 
a timer, then the “Set Value Channel” 
would be the timer number from the logic, 
and so on. 

Clear Text 64 characters <blank> No Text to include in log entries and alarm 
messages when the alarm is cleared. 

Clear Code 0 to 255 0 No 
The code to use for this alarm in alarm 
messages when the alarm status is 
cleared. 

Clear Value 
Type 

None, Battery Input 
Voltage, Timer, 
Digital Input, Relay 
Output, Logic Bit 

None No The value to include in the log entry or 
alarm message when the alarm is cleared. 

Clear Value 
Channel 0 to 4000 0 No 

The channel that determines where the 
executive will ready the Clear Value from 
according to the Clear Value Type. The 
“channel” corresponds to the type of value 
that is being included in the alarm. If the 
MCF is sending a “low battery” alarm and 
the “Set Value Type” is “Battery Input 
Voltage”, then the “Clear Value Channel” 
would be the battery input channel 
number to read the voltage from when the 
alarm is created. If the “Set Value Type” is 
a timer, then the “Clear Value Channel” 
would be the timer number from the logic, 
and so on. 
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The application engineer enters variable names for the Alarm logic states on this screen. The 
application engineer uses the variable names in the MCF logic. For a description of the Alarm 
logic states, see Table 4-23. 
 

Table 4-23   Alarms Logic States 

 

4.11 INSPECTIONS 

The WI can automatically perform periodic crossing inspections. The MCF logic determines 
when inspections pass. The executive software triggers the MCF logic to execute the 
inspections from an inspection schedule and by direct command from the web-browser user 
interface. 
 

4.11.1 INSPECTION TYPES  

The application engineer selects the type of inspection. The WI supports four types of 
inspections: Annual, Quarterly, Monthly, and Weekly. Annual inspections are intended to be run 
once per year. Quarterly inspections are intended to run once every three months, Monthly 
inspections are intended to run once per month, and weekly inspections are intended to run 
once per week. However, the frequency of running each inspection is determined by the 
inspection triggers as expected in section 4.11.3. 

4.11.2 INSPECTION STATES 

The WI considers each inspection in one of the following states:  
• No Results: The inspection has not been triggered to run yet or it was triggered and 

then abandoned before it passed. 
• Pending: The inspection has been triggered. The next time the conditions are 

appropriate for the inspection (e.g. next train move), the WI will perform the inspection. If 
the inspection does not pass, it remains pending and the WI will attempt to pass the 
inspection the next time the conditions are appropriate. Inspections remain pending until 
they pass or until a user abandons the inspection. 

Logic State Label Functional Description 

Input Logic States 

Alarm ACK State Reserved for future use. 

Output Logic States 

Alarm Set State 

When the MCF logic changes this logic state from clear to set, the WI will 
initiate the configured actions, unless the “Set Text” is blank. 
When the MCF logic changes this logic state from set to clear, the WI will 
initiate the configured actions, unless the “Clear Text” is blank.  
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• Passed: The inspection passed and there are passed results saved. The inspection has 
not been triggered to run again. When the inspection is triggered to run again, it will 
change to Pending. 

The WI never declares an inspection “failed.” There are a number of real-world reasons the 
automated inspection might not pass, even when the crossing warning system is performing 
correctly. This approach allows field personnel to fix an issue and then manually trigger the 
inspection again to get a pass. Or field personnel may abandon the inspection and perform it 
the traditional (not automated) way. 

4.11.3 INSPECTION TRIGGERS 

The system may trigger inspections to run (change state to Pending, see section 4.11.2) using 
three methods: Inspection Schedule, User Interface, and Back-office Commands. 
The user may load an Inspection Schedule into the WI, which defines the date and time to run 
each type of inspection.  The inspection schedule is just a text file. The user may type an 
inspection schedule by hand, provided the file syntax is followed (see Chapter 6). 
The user may manually trigger inspections using the WebUI, via the Inspection Status screen. 

4.11.4 INSPECTION TRIGGER LOGGING 

The WI adds an entry to the Event Log when inspections are triggered. The following is an 
example log entry: 
E1A1  23-Mar-2016 09:26:27.38  INSP   EB 1-1 Warning Time (234.259) 
triggered by user, Annual test 

 NOTE
 

Each event entry is a single line in the report. The entry is shown on two 
lines here due to space constraints. 

The event text includes the inspection name as programmed in the MCF. For the example entry 
above, the inspection name is “EB 1-1 Warning Time (234.259)”. The entry also includes how 
the inspection was triggered and the type of inspection. 

4.11.5 INSPECTION PASS LOGGING 

The WI adds an entry to the Event Log when an inspection passes. The following is an example 
log entry: 
DDE6  24-Mar-2016 12:53:40.43  INSP    

EB 1-1 Warning Time (234.259) Passed, Value: 21s, Annual Test 

 

 NOTE
 

Each event entry is a single line in the report. The entry is shown on two 
lines here due to space constraints. 
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The entry includes the time stamp of when the inspection passed, the inspection name as 
programmed in the MCF, the value associated with the inspection when it passed, and the type 
of inspection. For the above example, the inspection name is “EB 1-1 Warning Time (234.259)”, 
the measured warning time was 21 seconds, and this is an annual test. 
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4.11.6 INSPECTION PROGRAMMING USING MCT 

The application engineer configures inspection on the Inspections screen shown in Figure 4-12. 
 

 
Figure 4-12   Inspections Screen 

 
For a description of each inspection parameter, see Table 4-24. 
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Table 4-24   Inspections Configuration Parameters 

Parameter 
Name Range Default Web UI 

Editable Description 

Name 64 characters Inspection x No Name of the inspection, which will be used in the 
event log and reported inspection results. 

Inspection 
Type 

Annual, 
Quarterly, 
Monthly, 
Weekly 

Quarterly No 

Defines whether the inspection should be 
performed once per year (annual), once every 3 
months (quarterly), once per month (monthly), or 
once per week (weekly). 

Pass Value 
Type 

None, 
Battery Input 
Voltage, 
Timer, 
Digital Input, 
Relay Output, 
Logic Bit 

None No 
Inspections may include a value in the log entry 
and inspection results. This selects the type of 
value to include. 

Pass Value 
Channel 0 to 4000 0 No 

This specifies the channel of the pass value type 
to include in the results (e.g. battery input 1). 
The “channel” corresponds to the type of value 
that is being included in the inspection. If the 
“Pass Value Type” is a timer, then the “Pass 
Value Channel” would be the timer number from 
the logic, and so on. 

Speed 
Measurement 
Used 

Yes or No No No 
If Yes, the inspection results will also include a 
speed, in miles/hour (mph), in the log entry and 
inspection results. 

Speed 
Measurement 
Index 

1 to 64 1 No 

If Speed Measurement Used is Yes, this 
determines which entry in the Speed 
Measurement data to associate with this 
inspection. 

 
The application engineer enters variable names for the Inspections logic states on this screen.  
The application engineer uses the variable names in the relay logic. For a description of the 
Inspections logic states, see Table 4-25. 
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Table 4-25   Inspections Logic States 

 

4.12 GCP 4000, MS 4000, GCP 5000, AND GCP 3000+ INTERFACE 

The WI receives I/O statuses and configuration data messages from a GCP over a network. The 
I/O statuses and the configuration data statuses are available to the MCF logic, which 
eliminates the need to wire physical I/O from the GCP to the WI.  The WI supports an interface 
with all GCP 4000 models, MS 4000 models, GCP 5000 models and GCP 3000+ models. 
The WI monitors the link health with the GCP. If the WI stops receiving status messages from 
the GCP, it will set the link health status to unhealthy. The application engineer can set the 
timeout for the link health in the MCF. The link health status is available to the MCF logic. 
The WI receives the status of GCP I/O, which is available to the MCF logic. Since the GCP is 
highly configurable, not all I/O status are relevant in all conditions. The GCP reports the I/O 
statuses that are used in the GCP’s current configuration. The “used” statuses are available to 
the MCF logic.  
The WI will also log changes in the I/O statuses and configuration statuses, as reported from the 
GCP, into the event log. 
 

4.12.1 GENERAL GCP INTERFACE CONFIGURATION 

The application engineer configures the general GCP interface parameters on the General GCP 
Configuration screen shown in Figure 4-13. 

Logic State Label Functional Description 

Input Logic States 

Inspection Pending State 

The WI sets this logic state to trigger the MCF logic to run the 
inspection. The WI will set this logic state when the scheduled 
inspection date is reached, when manually triggered by a user, or 
by back-office command. The logic state will stay set until the MCF 
logic sets the Inspection Passed State or a user manually clears it 
via the web-browser user interface. 

Output Logic States 

Inspection Passed State 
The MCF logic sets this logic state to pass an Inspection. When 
set, the executive will log the current inspection results into the 
event log. It may also send the inspection results to the back-office.  
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Figure 4-13   General GCP Configuration Screen 

 
Table 4-26 describes each general GCP configuration parameter. 
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Table 4-26   General GCP Configuration Parameters 

Parameter 
Name Range Default Web UI 

Editable Description 

Name 20 characters GCP IF Yes Name used for the GCP interface in 
logs and reports. 

ATCS 
Subnode 0 to 99 16 Yes 

The ATCS subnode of the GCP.   
Note: The ATCS address of the WI 
and the GCP must have the same 
railroad, line, and group values. 

Send Status 
on Change Yes or No Yes Yes 

If Yes, the GCP will send status 
messages when any I/O status 
changes state, not just on the status 
message period. 

Cfg Msg 
Period 0 to 60 minutes 0 minutes Yes 

Time period between configuration 
messages. If 0, the GCP will send 
configuration messages only on 
initiation of the link and on 
configuration data changes. 

Status Msg 
Period 0 to 300 seconds 30 

seconds Yes 
Period of status messages. If 0, the 
GCP will not send periodic status 
messages. 

GCP Link 
Timeout 10 to 600 seconds 30 

seconds Yes 

If the WI does not receive messages 
from the GCP for this length of time, 
it will clear the Link Health logic state 
and log the connection as unhealthy. 
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4.12.2 GCP FILTER 

The WI supports an interface to the GCP 4000, the GCP 5000, and the GCP 3000+. The 
application engineer may filter the view in MCT to see only the logic states that apply to the type 
of GCP using the “GCP Filter” option. This is shown in the following figure. 
 

 
Figure 4-14   GCP Filter Option 

 
With the GCP Filter selected only the GCP modules and logic states associated with the 
selected GCP model will be displayed. However, all the logic states are present and available 
for all models in the MCF. The GCP Filter just filters and organizes the view. The application 
engineer can design one MCF to handle more than one GCP model. The selected GCP Filter 
does not restrict the MCF to only that GCP model. 
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4.12.3 GCP GENERAL PURPOSE LOGIC STATES 

The application engineer can name the general purpose logic states for a GCP 4000 as shown 
in Figure 4-14. Table 4-27 describes the available general purpose logic states for all GCP 
models. The table shows which logic states are displayed for the selected GCP Filter option. 

Table 4-27   GCP General Purpose Logic States 

Logic State Label 
GCP 

4000 / 
5000 

GCP 
3000+ 

MS 
4000 Functional Description 

Input Logic States 

Link Health Yes Yes Yes Is set while the communication link to the GCP 
is healthy. Clears when it is unhealthy. 

AND 1 XR State Yes Yes Yes Follows the AND 1 XR state in the GCP. 

AND 2 State Yes No No Follows the AND 2 state 

AND1 XR Enable Yes Yes No Follows the AND 1 XR Enable state in the GCP. 

AND 2 Enable Yes No No Follows the AND 2 Enable state 

Adv Preempt IP State Yes Yes No Set if the GCP advanced preempt input is 
energized. 

Adv Preempt OP State Yes Yes No Set if the GCP advanced preempt output is 
energized. 

GCP On Standby Yes Yes Yes Set if the GCP is running standby CPU and I/O 
modules instead of main CPU and I/O modules. 

Maint Call Yes Yes Yes Set if the GCP maint call output is energized. 

Configuration Logic States 

AND 1 Used Yes Yes No Set if AND1 is used in the GCP. 

AND 2 Used Yes No No Set if AND 2 is used in the GCP. 

AND 1 Enable Used Yes Yes No Set if AND 1 Enable is used in the GCP. 

AND 2 Enable Used Yes No No Set if AND 2 Enable is used in the GCP. 

Adv Preempt OP Used Yes Yes No Set if the Adv Preempt output is used in the 
GCP. 

Adv Preempt IP Used Yes Yes No Set if the Adv Preempt input is used in the GCP. 

GCP3000 Plus No Yes No Set if the connected GCP is a GCP 3000+. 
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4.12.4 GCP TRACK LOGIC STATES 

Each GCP model supports a different number of track modules. Each track module is listed on 
the MCF Configuration Tool and each has input logic states and configuration logic states. The 
number of track modules listed and the logic states shown will change based on the GCP Filter 
selected as shown in Figure 4-14. 
Figure 4-15 shows the MCF Configuration Tool screen to set the logic state names for a GCP 
4000 and GCP 5000 track module. The GCP 4000 and the GCP 5000 support 6 track modules. 
The GCP 3000+ supports 2 track modules. The MS 4000 supports 1 track module. 
 

 
Figure 4-15   GCP Track Module Logic States 

 
Table 4-28 describes each track module logic state and shows which logic states the MCF 
Configuration Tool will show for each GCP Filter option. 
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Table 4-28   GCP Track Module Input Logic States 

Logic State Label 
GCP 

4000 / 
5000 

GCP 
3000+ 

MS 
4000 Functional Description 

Island Occupied Yes Yes Yes 
Set – Island occupied 
Clear – Island unoccupied 

Prime State Yes Yes Yes 
Set – Prime predictor not predicted 
Clear – Prime predictor predicting arriving train 

DAX A Yes Yes No 

Set – DAX not predicted 
Clear – DAX predicts arriving train 

DAX B Yes Yes No 

DAX C Yes Yes No 

DAX D Yes Yes No 

DAX E Yes No No 

DAX F Yes No No 

DAX G Yes No No 

Preempt Yes No No Set – Preempt predictor not predicted 
Clears – Preempt predictor predicts arriving train 

Prime UAX State Yes Yes Yes 
Set – UAX input is energized 
Clear – UAX input is de-energized 

DAX A Enable Yes No No 

Set – DAX Enable input is energized 
Clear – DAX Enable input is de-energized 

DAX B Enable Yes No No 

DAX C Enable Yes No No 

DAX D Enable Yes No No 

DAX E Enable Yes No No 

DAX F Enable Yes No No 

DAX G Enable Yes No No 

Preempt Enable Yes No No 
Set – Preempt Enable input is energized 
Clear – Preempt Enable input is de-energized 

GCP Card Health Yes Yes Yes Set if the track module is healthy. 
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GCP OOS Yes Yes Yes Set if the track module has been taken out of 
service. 

Island OOS Yes Yes Yes Set if the island circuit of the track module has 
been taken out of service. 

IN 1.1 Yes Yes Yes Set if input 1 on the track card is energized. 

IN 1.2 Yes Yes Yes Set if input 2 on the track card is energized. 

VRO 1 State Yes Yes Yes Set if vital relay output 1 is energized on the 
track card. 

VRO 2 State Yes Yes Yes Set if vital relay output 2 is energized on the 
track card. 

Train On Approach Yes Yes Yes Clears when a train is on the approach. 

Train Inbound Yes Yes Yes Clears when there is an inbound train (train 
moving toward the island). 

Trk Wrapped Yes No No Set if the track circuit is wrapped. 

Direction Isl Tx to Rx Yes No No 

Set if the direction of the train is from the 
transmitter towards the receiver as measured on 
the inbound move.  The MCF logic should 
ensure the “Direction Available” logic state is set 
before using this logic state. 

Direction Isl Rx to Tx Yes No No 

Set if the direction of the train is from the receiver 
towards the transmitter  as measured on the 
inbound move.   The MCF logic should ensure 
the “Direction Available” logic state is set before 
using this logic state. 

Outbound RX Yes No No Set if there is an outbound train that is moving 
from the transmitter towards the receiver. 

Outbound TX Yes No No Set if there is an outbound train moving from the 
receiver towards the transmitter. 
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Table 4-29   GCP Track Module Configuration Logic States 

Logic State Label 
GCP 

4000 / 
5000 

GCP 
3000+ 

MS 
4000 Functional Description 

Track x Used Yes Yes Yes 
Set if the track card is used in the GCP configuration. 
The following GCP Track logic states should be 
ignored if the track is not used. 

Track x GCP Used Yes No No Set if the approach track circuit on the track module is 
used. 

Track x Island Used Yes Yes Yes Set if the island track circuit on the track module is 
used. 

Track x Prime Used Yes Yes Yes Set if the prime predictor on the track module is used. 

Track x DAX A Used Yes Yes No 

Set if the DAX predictor on the track module is used. 

Track x DAX B Used Yes Yes No 

Track x DAX C Used Yes Yes No 

Track x DAX D Used Yes Yes No 

Track x DAX E Used Yes No No 

Track x DAX F Used Yes No No 

Track x DAX G Used Yes No No 

Track x Preempt Used Yes No No Set if the preempt predictor on the track module is 
used. 

Prime UAX Used Yes Yes Yes Set if the Prime UAX has been enabled. 

Track x DAX A Enable Used Yes No No 

Set if the DAX Enable has been enabled. 
Track x DAX B Enable Used Yes No No 

Track x DAX C Enable Used Yes No No 

Track x DAX D Enable Used Yes No No 

Track x DAX E Enable Used Yes No No 

Set if the DAX Enable has been enabled. Track x DAX F Enable Used Yes No No 

Track x DAX G Enable Used Yes No No 
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4.12.5 GCP SSCC MODULE LOGIC STATES 

The GCP 4000 and GCP 5000 support integrated solid state crossing controllers (SSCC) 
modules. The GCP 3000+ and the MS 4000 do not support the SSCC modules. If the GCP 
3000+ or the MS 4000 is selected in the GCP Filter option, the SSCC module logic states will 
not be displayed. Figure 4-16 shows the MCF Configuration Tool screen where the application 
engineer can name the logic states. 
 

 
Figure 4-16   GCP SSCC Module Logic States Screen 

Table 4-30 describes each logic state. 

Track x Wrap Used Yes No No Set if the track wrap input of the track module has 
been enabled. 

Direction Available Yes No No Set if direction statuses are valid and can be used in 
logic. 
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Table 4-30   GCP SSCC Module Logic States 

 

4.12.6 GCP RIO MODULE LOGIC STATES 

The GCP 4000 and GCP 5000 support up to 3 RIO modules. The GCP 3000+ supports one 
RIO module. The MS 4000 does not support a RIO module. The MCF Configuration Tool screen 
to name the GCP RIO module logic states is shown in Figure 4-17. 

Logic State Label Functional Description 

Input Logic States 

SSCC x GC 
Set if the gate control output of the SSCC is energized. 
Clear if the gate control output of the SSCC module is de-energized. 

SSCC x Bell 
Set if the bell output of the SSCC module is energized. 
Clear if the bell output of the SSCC module is de-energized. 

SSCC x Lamps Flashing 
Set if the lamp output of the SSCC module is flashing. 
Clear if the lamp output of the SSCC module is not flashing. 

SSCC x Non Vital Health Set if the non-vital health of the SSCC module is good. 

SSCC x Vital Health Set if the vital health of the SSCC module is good. 

Logic State Label Functional Description 

IN x.1 

Set if the SSCC Module input used and is energized. 

IN x.2 

IN x.3 

IN x.4 

IN x.5 

Configuration Logic States 

SSCC 1 Used Set if the SSCC module is used in the GCP configuration. 
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Figure 4-17   GCP RIO Module Logic States Screen 

 
Table 4-31 describes the GCP RIO module logic states and shows which logic states the MCF 
Configuration Tool will show for each GCP Filter option. The label of the logic states is different 
depending on the GCP Filter option selected. 
The MS 4000 does not include a RIO module; therefore, the MCF Configuration Tool hides the 
RIO module logic states when the MS 4000 filter is selected. 
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Table 4-31   GCP RIO Module Logic States 

GCP 4000 / 5000 
Logic State Label 

GCP 3000+  
Logic State Label Functional Description 

Input Logic States 

IN 2.1 IN 3.1 

Set if the RIO module input is energized and clear 
otherwise (input de-energized or failed). 

IN 2.2 IN 3.2 

IN 2.3 IN 3.3 

IN 2.4 IN 3.4 

Out 2.1 Out 3.1 

Set if the RIO module output is energized and clear 
otherwise (output de-energized or failed). 

Out 2.2 Out 3.2 

Out 2.3 Out 3.3 

Out 2.4 Out 3.4 

IN 5.1 N/A 

Set if the RIO module input is energized and clear 
otherwise (input de-energized or failed). 

IN 5.2 N/A 

IN 5.3 N/A 

IN 5.4 N/A 

Out 5.1 N/A 

Set if the RIO module output is energized and clear 
otherwise (output de-energized or failed). 

Out 5.2 N/A 

Out 5.3 N/A 

Out 5.4 N/A 

IN 6.1 N/A 

Set if the RIO module input is energized and clear 
otherwise (input de-energized or failed). 

IN 6.2 N/A 

IN 6.3 N/A 

IN 6.4 N/A 

Out 6.1 N/A 

Set if the RIO module output is energized and clear 
otherwise (output de-energized or failed). 

Out 6.2 N/A 

Out 6.3 N/A 

Out 6.4 N/A 
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Configuration Logic States 

RIO 1 Used RIO 1 Used 
Set if the RIO module is used in the GCP 
configuration. 
Clear if the RIO module is not used. 

RIO 2 Used N/A 

RIO 3 Used N/A 
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4.12.7 GCP MODULE COMMS LOGIC STATES 

The GCP reports the status of the communication with the I/O modules to the WI. Figure 4-18 
shows the MCF Configuration Tool screen to name the Module Comms logic states. 

 
Figure 4-18   GCP Module Comms Logic States Screen 

 
Table 4-32 describes the GCP Module Comms logic states and indicates which states are 
shown based on the GCP Filter selection. 
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Table 4-32   GCP Module Comms Logic States 

 

4.13 TRAIN SPEED 

To properly perform warning time tests, the WI must ensure the train was moving through the 
crossing at or near the maximum permissible speed for the route. The WI provides two methods 
to get train speed: calculate the speed or receive the speed from a GCP. 
The WI determines the train speed and informs the MCF logic through logic states. The MCF 
configuration data includes a “Speed Measurement Entry” for each speed the executive needs 
to check. The WI supports up to 64 speed measurement entries.  
Figure 4-19 shows the MCF Configuration Tool screen to configure a speed measurement and 
name the available logic states when receiving the speed from a connected GCP. 

Logic State Label GCP 
4000/5000 

GCP 
3000+ 

MS 
4000 Functional Description 

Input Logic States 

Slot 2 Comms Yes Yes Yes 

Set if the communication between 
the GCP CPU and the I/O module in 
the indicated slot is good. 

Slot 3 Comms Yes Yes No 

Slot 4 Comms Yes Yes No 

Slot 5 Comms Yes No No 

Slot 6 Comms Yes No No 

Slot 7 Comms Yes No No 

Slot 8 Comms Yes No No 

Slot 9 Comms Yes No No 
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Figure 4-19   Speed Measurement for Receiving Speed from GCP 

 
Figure 4-20 shows the MCF Configuration Tool screen when the WI calculates the train speed 
using I/O state changes. 
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Figure 4-20   Speed Measurement for Speed Calculations from I/O Changes 

 
Table 4-33 describes the speed measurement configuration parameters. 
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Table 4-33   Speed Measurements Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

Name 20 characters Speed 
Measurem
ent 

No The name used for the speed 
measurement entry in logs and reports. 

Speed 
Selection 

Calculate, 
GCP Trk 1 Isl Speed, 
GCP Trk 2 Isl Speed, 
GCP Trk 3 Isl Speed, 
GCP Trk 4 Isl Speed, 
GCP Trk 5 Isl Speed, 
GCP Trk 6 Isl Speed 

Calculate 
Speed 

No Selects the method of determining 
speed. 

Comparison 
Speed 

0 to 255 mph 0 mph Yes If the calculated speed or reported speed 
from the GCP is greater than or equal to 
this value, the WI will set the “Speed 
Comparison Result” logic state. 

Distance 0 to 65535 ft. 0 ft. Yes The distance to use in the speed 
calculation, which should be set to the 
distance the train travels between 
activations of Start Timer and Stop 
Timer.  
Only shown if Speed Selection is 
Calculate Speed. 

Time 
Adjustment 

-12.8 to 12.7 seconds 0 seconds Yes Time value used to adjust the speed 
calculation to account for de-bounce or 
other system delays. 
The Time Adjustment should be 
calculated as the delay on Start Timer 
clearing minus the delay on Stop Timer 
clearing (see section 4.13.2.3 for an 
example). 
Only shown if Speed Selection is 
Calculate Speed. 

Calculation 
Timeout  

0 to 65535 seconds 180 
seconds 

Yes Time limit on a complete speed 
calculation. If both speed measurement 
inputs do not change state within this 
length of time, the WI will abandon the 
speed calculation. 
Only shown if Speed Selection is 
Calculate Speed. 
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4.13.1 SPEED CALCULATIONS FROM I/O CHANGES 

The WI can calculate the train speed based on the timing between two input changes and a 
known distance the train travels between those changes.  
The MCF logic drives the speed calculation process. The WI performs the speed calculation, 
compares the calculated speed to the configured Comparison speed, and sets the Speed 
Comparison Result and Result Ready logic states for the result. The MCF logic uses those logic 
states in the warning time inspection logic. Table 4-34 describes the logic states available to the 
MCF logic. 

Table 4-34   Speed Calculation Logic States 

Logic State Description 

Input Logic States 

Speed Comparison Result The value of this logic state is only valid when the Result Ready 
logic state is set.  The WI will set this logic state if the calculated 
speed is greater than or equal to the Comparison Speed value. 
Once set, this logic state remains set until the MCF logic sets the 
Clear Speed Result logic state. 

Result Ready The WI sets this logic state when the WI completes a calculation 
and comparison. This logic state signals the MCF logic that the 
Speed Comparison Result is now valid. 
Once set, this logic state remains set until the MCF logic sets the 
Clear Speed Result logic state. 

Output Logic States 

Clear Speed Result Once the MCF logic has used the speed result, it sets this logic 
state to clear the results in preparation for the next calculation. 

Start Timer When Start Timer clears (changes from 1 to 0), the executive 
software will start an internal timer. 

Stop Timer When Stop Timer clears (changes from 1 to 0), the executive 
software will stop the internal timer, calculate the speed, compare 
the result to Comparison Speed, and inform the MCF logic the 
result is ready. 

 
 



FUNCTIONS, CONFIGURATION PARAMETERS, & LOGIC STATE DEFINITIONS 

 

4-61 

Document No.: SIG-00-16-05   SEPTEMBER 2016 (REVISED APRIL 2021) 

Version: A.1 

The WI uses Equation 4-1 to calculate train speed: 

 
Equation 4-1   Train Speed Calculation 

 

 NOTE
 

15/22 is the conversion factor for feet per second to miles per hour. 

 
The TimerValue is the number of elapsed seconds (to the tenth of a second) between Start 
Timer clearing and Stop Timer clearing. When the MCF clears Stop Timer, the executive 
calculates the speed and compares the result with the Comparison Speed. Distance and 
TimeAdjustment are configuration settings. If the calculated speed is greater than or equal to 
the Comparison Speed, the executive will set the Speed Comparison Result logic state. After 
the comparison, the executive sets Result Ready to inform the MCF logic the result is available. 

4.13.2 SPEED CALCULATION EXAMPLE 

To illustrate speed calculations from I/O state changes, consider the following example 
crossing. The crossing has a single bidirectional track circuit and an island circuit. 

 
Figure 4-21   Example Bidirectional Crossing 

 
For this crossing, assume a non-Siemens predictor, which does not have a messaging interface 
with the WI. 
For this crossing, the WI needs to test the warning time for two routes: eastbound and 
westbound. The MCF will use two Speed Measurement entries, one for each route. 
For eastbound trains, the MCF will use Entry 1. The MCF will drive Entry 1 Start Timer from the 
WiMag sensor status. It will drive Entry 1 Stop Timer from the Island input. 
For westbound trains, the MCF will use Entry 2. The MCF will drive Entry 2 Start Timer from the 
Island input and the Entry 2 Stop Timer from the WiMag sensor status. 









+

=
mentTimeAdjustTimerValue

DistanceSpeed
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4.13.2.1 COMPARISON SPEED 
For this fictional crossing location, the maximum permissible speed is 55 mph. The MCF logic 
will consider trains traveling 50 mph or greater as “fast enough” to use for the warning time test; 
therefore, the Comparison Speed is set to 50 mph for both Entry 1 and Entry 2. 

4.13.2.2 DISTANCES 
For eastbound trains, the train will activate the WiMag sensor first, then the near side of the 
island circuit. Therefore, the Distance value for Entry 1 is 500 feet. For westbound trains, the 
train will activate the far side of the island first and then the WiMag sensor. Therefore, the 
Distance value for Entry 2 is 530 feet. 

4.13.2.3 TIME ADJUSTMENT 
The application engineer will determine the time adjustment values specific to the application. 
The time adjustment is calculated by taking the delay for the Start Timer and subtracting from 
that the delay for the Stop Timer. The Time Adjustment is a value in seconds with one decimal 
place. 
For this example, assume a 500 ms de-bounce on the WiMag sensor status and a 1.0 s de-
bounce on the Island input, regardless of train direction. 
For Entry 1 (eastbound trains), the Time Adjustment must be set to -0.5 seconds (0.5s – 1.0s). 
For Entry 2 (westbound trains), the Time Adjustment must be set to +0.5 seconds (1.0s – 0.5s). 

4.13.2.4 CALCULATIONS 
For an eastbound train traveling at 55 mph, the MCF will clear Start Timer after the train crosses 
the WiMag sensor (plus de-bounce).  It will take the train 6.2 seconds to travel the 500 feet to 
the island. When the train reaches the island, the MCF will clear the Stop Timer. However, due 
to de-bounces, the internal timer value will be 6.7 seconds. When Stop Timer clears, the 
executive will calculate the speed as shown below: 
 

Equation 4-2   Example Eastbound Speed Calculation 
 

 NOTE
 

The WI will round the calculated speed to the nearest integer value of 
mph. 

 
The result is greater than or equal to the Comparison Speed of 50 mph. The executive will set 
Entry 1 Speed Result, which the MCF logic can use to pass the eastbound train warning time 
inspection (assuming the warning time was good). 

559.54
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The reverse applies to westbound trains. A 55 mph train travels 530 feet in about 6.6 seconds. 
However, due to de-bounces, the internal timer will be 6.1 seconds. The following is the 
resulting calculation: 
 

Equation 4-3   Example Westbound Speed Calculation 
 

4.13.2.5 EXAMPLE LOGIC 
The MCF logic circuit to pass the warning time inspection for eastbound trains might look 
something like the following simplified example: 
 

 
Figure 4-22   Warning Time Inspection Relay Logic 

Where:  
• EastbdInspPend is the “inspection pending” logic state for the inspection (set when the 

inspection has been triggered). 
• WarnTimeOk is a logic equation that is set when the warning time was good. 
• DirIsEast is a logic equation, which is set when the train direction was eastbound. 
• EastbdSpdRdy is the Entry 1 Result Ready logic state. The logic must check this bit to 

ensure the speed result is ready. 
• EastbdSpdOk is the Entry 1 Speed Result logic state, which the executive sets if the 

calculated train speed was greater than or equal to 50 mph. 
• EastbdInspPass is the logic state to set to signal the executive to pass the inspection. 
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The MCF logic circuit for the Entry 1 Start and Stop Timer might look something like the 
following:  

Figure 4-23   Start and Stop Timer Logic Rungs 
 
EastbdSpdStart is Entry 1 Start Timer (variable name is assigned in the MCF Configuration 
Tool). The WI starts the speed calculation timer when EastbdSpdStart clears. The 
EastbdSpdStart equation will clear when XR drops AND the WiMag sensor is on AND there is 
no WiMag sensor error. The XR was ANDed into the logic just to ensure a speed calculation is 
not started when there is no crossing activation (e.g. WiMag sensor incorrectly reports active). 
EastbdSpdStop is Entry 1 Stop Timer. The WI stops the speed calculation timer and calculates 
speed when EastbdSpdStop clears. The circuit above means the calculation happens when the 
island drops AND the Entry 1 Start Timer has already been cleared. 
The westbound Start and Stop equations are left as an exercise to the reader. 
 
Speed Calculation Recommendation 
If the Distance value is small and the train speed is high, small errors in the time measurement 
will result in large errors in the speed calculation. It is recommended to use as large a Distance 
as possible to reduce the effect of time measurement errors. 

4.13.3 GCP-REPORTED SPEEDS 

At crossings using the Siemens GCP models, the WI does not need to calculate the speed. The 
GCP reports the speed to the WI. The Speed Measurement Entry will identify which island 
speed, reported from the GCP, to compare to the Comparison Speed. The executive will set the 
Speed Comparison Result logic state and Result Ready after the WI receives the island speed 
from the GCP. 
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4.14 ILOD  

The WI can receive current measurements from an A80271 iLOD. It can communicate with a 
maximum of four concurrent iLOD units. 

4.14.1 ILOD GENERAL CONFIGURATION PARAMETERS AND LOGIC STATES 

Figure 4-24 shows the MCF Configuration Tool screen to configure the iLOD settings and name 
the iLOD logic states. 
The echelon node is determined automatically by the MCF Configuration Tool. The user does 
not enter it. It is shown for informational purposes only. 
 

 
Figure 4-24   iLOD General Configuration Screen 

 
Table 4-35 describes the iLOD configuration parameters. 
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Table 4-35   iLOD General Configuration Parameters 

Parameter 
Name 

Range Default Web UI 
Editable 

Description 

iLOD Name 0 - 20 
characters 

iLODx Yes The name of the iLOD module to 
use in logging and reports. 

 
Table 4-36 describes the iLOD general logic states available to the MCF logic. 
 

Table 4-36   iLOD General Logic States 

 
 
 
 
 
 
 

4.14.2 ILOD SENSOR CONFIGURATION PARAMETERS AND LOGIC STATES 

Each iLOD unit has two current sensors. Figure 4-25 shows the MCF Configuration Tool screen 
to configure an iLOD sensor and to name the iLOD logic states. 

Logic State Label Functional Description 

Input Logic States 

Health Set when the iLOD communications is healthy. 

FactoryCal Set when factory calibration has been performed. 

FieldCal Set when field calibration has been performed. 
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Figure 4-25   iLOD Sensor Configuration Screen 

 
Table 4-37 describes the iLOD sensor configuration parameters. 
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Table 4-37   iLOD Sensor Configuration Parameters 

Parameter Name Range Default Web UI 
Editable 

Description 

Sensor Name 0 - 12 
characters 

iLODxSensY No The name to use for the iLOD sensor in 
logging and reports. 

Sensor Algorithm Unused, 
LOD 
Mode, 
Steady 
Current 
Mode 

LOD Mode Yes If Unused is selected, the sensor will be 
ignored. 

If LOD Mode is selected, the iLOD sensor 
will measure current and flash rate for 
flashing lamps. 

If Steady Current Mode is selected, the 
iLOD sensor will measure steady current 
only. 

Sample Size 5 to 32 16 Yes If the selected sensor algorithm is “LOD 
Mode,” this parameter is not used. 
If the selected sensor algorithm is “Steady 
Current Mode” this parameter specifies the 
number of samples to average together to 
determine the measured current.  

Flash Rate Delta / 
Sample Interval 

10 to 200 
ms 

10 Yes If the selected sensor algorithm is “LOD 
Mode,” this parameter specifies the change 
in the measured flash rate necessary to 
trigger a new flash rate event from the iLOD. 
If the selected sensor algorithm is “Steady 
Current Mode” this parameter specifies how 
often the iLOD should sample the current 
being measured. 

Delta (A) 0.0 to 9.9 
amps 

0.5 Yes Specifies the change in measured current 
necessary to trigger a new current 
measurement event from the iLOD. 

FPM threshold 1 - 4 0 to 255 
f/m 

0 Yes Specifies threshold values to trigger logic 
state changes in the MCF logic. If the 
reported flash rate for this sensor is greater 
than or equal to the threshold value, the 
executive software will set the 
corresponding logic state input to the MCF 
to TRUE. 

Current threshold 1-
2 

0.0 to 30.0 
amps 

0 Yes Specifies the threshold values to trigger 
logic state changes in the MCF logic. If the 
reported current for this sensor is greater 
than or equal to the threshold value, the 
executive software will set the 
corresponding logic state input to the MCF 
to TRUE. 
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Table 4-38 describes the iLOD sensor logic states. 
 

Table 4-38   iLOD Sensor Logic States 

 
For further information relating to the iLOD, refer to the iLOD (A80271) User Guide, 
SIG-00-03-05-005. 
 

4.15 MAINTAINER ON-SITE MODE 

Maintainer on Site mode allows field personnel to test and modify the crossing without sending 
alarm messages to the office. When field personnel press the On-site Personnel button, the WI 
goes into Maintainer on Site mode and starts a timer. The WI will not send alarm messages to 
the office while in Maintainer on Site mode. The WI returns to normal operation when the timer 
expires. The Alarms Suppressed LED will be on while the WI is in Maintainer on Site mode. The 
maintainer may re-start the timer for Maintainer on Site mode by pressing the On-Site Personnel 
button again, at any time. 
The default length of time for Maintainer on Site mode is set in the MCF. The application 
engineer can modify the default Maintainer on Site Time in the MCT on the General settings 
page as shown in the following figure. Field personnel may change the Maintainer on Site Time 
from the WI web UI. 

Logic State Label Functional Description 

Input Logic States 

LODMode Set when the iLOD sensor is configured in LOD mode (measures current 
for flashing crossing lamps). 

Current Mode Set when the iLOD sensor is configured in steady current mode. 

Is AC 

Set when the measured sensor current is AC current. This logic state is 
mutually exclusive to the “Is DC” logic state. If neither “Is AC” nor “Is DC” 
are set, there is no measured current (lamps are off or current not reported 
yet). 

Is DC 

Set when the measured sensor current is DC current. This logic state is 
mutually exclusive to the “Is AC” logic state. If neither “Is AC” nor “Is DC” 
are set, there is no measured current (lamps are off or current not reported 
yet). 

Lamps On Set when the iLOD detects the Lamps are on for this channel. 

OverFlash Rate1 – 
OverFlash Rate4 

Set when the last reported flash rate is greater than or equal to the 
corresponding FPM Threshold value. 

OverCurrent1 - 
OverCurrent4 

Set when the last reported current is greater than or equal to the 
corresponding Current Threshold value. 
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Figure 4-26   General Screen showing Maintainer on Site Time 
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4.16 WIMAG SENSORS 

The WI can receive on/off status from a wireless magnetometer (WiMag) sensor system. The 
WiMag sensors detect changes in the magnetic field above the sensor. The sensors can be 
used for non-vital train detection to aid in determine the direction or the route or a train through 
a crossing. The WI connects to the WiMag sensor system over the Ethernet network. 

Table 4-39   WiMag Base Parameter Values 

Parameter 
Name Range Default Web UI 

Editable Description 

UDP Listen 
Port 

1 to 
65535 7253 Yes The UDP port the WI will listen on for 

WiMag sensor status messages. 

Base Status 
Timeout 

0s to 
255s 10s Yes 

If the WI does not receive a status update 
from the WiMag base station in this amount 
of time, it will declare the link as failed. 

 
Table 4-40   WiMag Sensors Parameter Values 

Parameter 
Name Range Default Web UI 

Editable Description 

Senor Used Yes or No No No If set to Yes, the WI will expect status 
updates for this sensor. 

Sensor 
Name 

20 
characters 

Sensor 
x Yes 

The name used when logging state 
changes to the event log and on reports. 
Only visible if Sensor Used is Yes. 

Sensor Off 
Debounce 

0ms to 
60,000ms 100ms Yes 

The sensor must report off for this length 
of time, continuously, before the WI will 
declare the status as OFF. Only visible if 
Sensor Used is Yes. 

Sensor On 
Debounce 

0ms to 
60,000ms 500ms Yes 

The sensor must report on for this length 
of time, continuously, before the WI will 
declare the status as ON. Only visible if 
Sensor Used is Yes. 

Off Name Off state 
name list OFF Yes 

The name used for the OFF state when 
logging state changes to the event log. 
Only visible if Sensor Used is Yes. 

On Name On state 
name list ON Yes 

The name used for the ON state when 
logging state changes to the event log. 
Only visible if Sensor Used is Yes. 



FUNCTIONS, CONFIGURATION PARAMETERS, & LOGIC STATE DEFINITIONS 

 

4-72 

Document No.: SIG-00-16-05   SEPTEMBER 2016 (REVISED APRIL 2021) 

Version: A.1 

 
Table 4-41   WiMag Logic States 

 
  

Logic State Label Functional Description 

Base Comms Status Set by the executive while the communication link with the WiMag Access 
Point (base station) is good. 

Sensor Detected State Set by the executive when the WiMag sensor is detecting a train over it and 
clear otherwise. 

Sensor Error State Set if there is a problem with the sensor (sensor h/w failure or comms 
timeout with this sensor). 
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CHAPTER 5  PER-UNIT CONFIGURATION PARAMETERS 

This chapter provides a reference to the per-unit configuration parameters of the WI. These configuration 
parameters are not shown or editable in the MCF Configuration Tool. These configuration parameters 
are only available through the web-browser user interface of the WI and must be set by field personnel at 
the time the WI is installed. See the Wayside Inspector Installation & Instruction manual,  
SIG 00-16-03, for the web-browser user interface screens for these settings. 
 

5.1 SITE INFORMATION 

 
Table 5-1   Site Information Configuration Parameters 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Site 
Configuration 

Site Name 20 characters Inspection Site The name of the 
site printed on 
reports and 
downloads. 

DOT 
Number 

7 characters 000000A The DOT number 
assigned to the 
installation 

Mile Post 20 characters 000.0 The mile post 
location of the 
installation. 

Time Zone Greenwich Mean Time (GMT), 
Eastern, Central, Mountain, 
Pacific, Alaska, Atlantic, 
Arizona (no DST), 
Newfoundland 

Eastern The time zone of 
the installation. 

ATCS 
Address 

Type 7 ATCS address 7.620.100.100.03 The ATCS 
address of the 
installation. 
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5.2 NETWORKING 

Table 5-2   Networking: Comms Interface Configuration Parameters 

Web UI Screen Parameter 
Name 

Range Default Description 

Networking: 
Comms 
Interface 

DHCP 
Mode 

Disabled or 
Client 

Disabled If set to Client, the WI will request the 
network settings using the DHCP 
protocol. If set to Disabled, the 
interface uses static settings. 

IP Address IPv4 
Address 

192.168.2.100 The IPv4 address of the Network 
Ethernet interface. 
Only visible if DHCP Mode is Disabled. 

Network 
Mask 

IPv4 
Address 

255.255.255.0 The network mask of the Network 
Ethernet interface. 
Only visible if DHCP Mode is Disabled. 

Default 
Gateway 

IPv4 
Address or 
Blank 

Blank The default gateway of the Network 
Ethernet interface. Leaving the field 
blank means no default gateway used. 
Only visible if DHCP Mode is Disabled. 

 
Table 5-3   Networking: Domain Name System Configuration Parameters 

Web UI Screen Parameter 
Name 

Range Default Description 

Networking: Domain 
Name System 

Name Server 
1 

IPv4 Address 
or Blank 

Blank IP address of the primary name 
server for use with name resolution. 

Name Server 
2 

IPv4 Address 
or Blank 

Blank IP address of the secondary name 
server for use with name resolution. 
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Table 5-4   Networking: ATCS/IP Field Protocol Parameter Values 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Networking: 
ATCS/IP Field 
Protocol 

ATCS/IP Field 
Protocol 
Enabled 

Yes or 
No 

No If set to Yes, enables the ATCS/IP 
Field Protocol, which is used for 
communication to other ATCS 
systems installed on a network, such 
as the Siemens GCP. 

UDP Port 1024 to 
65535 

5000 The UDP port to use for the ATCS 
messages. 

Broadcast IP 
Address 

IPv4 
Address 

255.255.255.255 The WI will send ATCS packets to 
this address if it has not yet 
discovered the IP address 
associated with the ATCS destination 
address. 
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Table 5-5   Networking: ATCS/IP Office Protocol Configuration Parameters 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Networking: 
ATCS/IP 
Office 
Protocol 

Circuit ID 
Line 

0 - 999 000 The circuit ID is a unique ID of the WI 
used by OCG and Packet Switches. 

Circuit ID 
Port 

0 - 2 0 

Circuit ID 
Poll 

0 - 15 00 

Routing 
Region One 

0.0.0.0 - 
255.255.255.255 
or Symbolic Name 

192.168.X.2 
where X is 
replaced with 
the Port Number 
plus one. 

This can be either a subnet broadcast 
or unicast IP address associated with 
office OCG or packet switch. 

Routing 
Region Two 

0.0.0.0 - 
255.255.255.255 
or Symbolic Name 

192.168.X.3 
where X is 
replaced with 
the Port Number 
plus one. 

This can be either a subnet broadcast 
or unicast IP address associated with 
office OCG or packet switch. 

UDP Port 0 - 65535 5361 Specifies the port number used to 
listen for messages. Specifies the 
UDP port number used to listen for 
messages. 

Path Value 0 - 255 72 This is information used by packet 
switch/OCG to specify inbound path 
options such as main/standby, field 
device operation, etc. The path value 
is determined by the application 
engineer or the railroad 
communication personnel. In most 
cases, the default need not be 
changed. 

Route 
Search Time 

0 - 65535 seconds 15 Seconds Route request is sent per this time 
interval until a route update response 
is received. 

Route 
Refresh 
Time 

0 - 65535 Minutes 5 Minutes Once a route update response is 
received, a route request is 
periodically sent per this time interval 
to refresh the route table. 

Route 
Search Tries 

0 - 255 4 The number of times the WI will retry 
a route search if a response is not 
received. 
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5.3 WAMS/RAILFUSION 

 
Table 5-6   WAMS / RailFusion Configuration Parameters 

Web UI 
Screen 

Parameter Name Range Default Description 

WAMS / 
RailFusion 

WAMS/RailFusion 
Messaging Enabled 

Yes, No No Allows the WI to interface with WAMS 
and RailFusion systems. 

ATCS Address 2.000.00.0000 
to 
2.999.99.9999 

2.620.01.9100 The ATCS Address of the Target 
System, padded out to 6 bytes. If it is 
a type 7 ATCS Address, it does not 
include the DD field 
(7.RRR.LLL.GGG.SS) 

Alarm Retry Time 
(sec) 

0 to 65535 
seconds 

75 A value of 0 means alarms will not be 
retried. 
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5.4 SERIAL PORT 

Table 5-7   Serial Port Parameter Values 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Serial Port 
Parameters 

Baud Rate 1200 - 115200 9600 Sets the serial port’s baud rate in bits per 
second. 

Data Bits 7, 8 8 Sets the number of data bits to use in each 
character transmitted. 

Parity None, Odd, Even None Sets the parity bit mode. 

Stop Bits 1, 2 1 Sets the number of stop bits to use in each 
character transmitted. 

Flow Ctrl None, Hardware, 
Radio/Modem 

None Select the flow control method to use for the 
serial port. “Hardware” selects the typical 
CTS/RTS handshake method. 
“Radio/Modem” is not currently supported. 

Protocol None, Gen/ATCS 
Field, Genisys 
Field, GCP 3000 

None At this time, the WI only supports the GCP 3000 
protocol. If “GCP 3000” is selected, the WI will 
poll an external legacy 3000 Grade Crossing 
Predictor for its configuration and event 
information. For further information, refer to the 
Wayside Inspector Installation & 
Instruction Manual, SIG-00-16-03. 
Support for the “Gen/ATCS Field” protocol and 
the “Genisys Field” protocol may be added in a 
future release. 
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5.5 LOGGING 

 
Table 5-8   Log Setup: Diagnostic Logging Parameter Values 

Screen Parameter Name Range Default Description 

Log Setup: 
Diagnostic 
Logging 

Diagnostic Log 
Verbosity 

Error, 
Warning, 
Info, 
Debug 

Info Sets the level of diagnostic entries to 
include in the diagnostic log. The selected 
level includes all entries at that level and 
lower (e.g. Info includes all Error, 
Warning, and Info entries in the 
diagnostic log). 

WAMS/RailFusion 
Message Logging 
Enabled 

Yes or 
No 

No Enables logging of WAMS/RailFusion 
messages sent and received by the WI 
into the WI’s diagnostic log. 

Routing Logging 
Enabled 

Yes or 
No 

No Enables logging of the internal ATCS 
message router functionality, which 
shows ATCS messages and their 
contents (starting with ATCS layer 3 
header) in the diagnostic log. 

Comms Serial 
Logging Enabled 

Yes or 
No 

No Future Feature. 

Network Protocol 
Logging Enabled 

Yes or 
No 

No Enables logging of any enabled network 
protocol, such as ATCS/IP Field. The 
diagnostic log will include entries showing 
the sent and received message data, 
including the network protocol specific 
headers. 

 

5.6 ATCS MESSAGE ROUTING 

Table 5-9   ATCS Message Routing Parameter Values 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

ATCS 
Message 
Routing 

Route 
Timeout 

0 to 
172,800 
seconds 

300 
seconds 

The length of time, in seconds, the WI will hold 
the ATCS route information for a discovered 
device before discarding it. A value of 0 means 
entries will never time out. 
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5.7 TIME MANAGEMENT 

Table 5-10   Time Management Screen 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Time 
Management 

Time Source Manual 
Only 

Manual 
Only 

Manual Only is currently the only supported 
option. The user can set the time from the web 
browser user interface and the WI will set the 
time when a message is received on the WAMS 
interface or the SDP interface. 

Minimum 
Time 
Difference 

0 – 60 
sec 

2 Minimum amount of time difference between 
received time and system time before the WI will 
set the time from the time source. 

 

5.8 SECURITY 

Table 5-11   Security: Password Configuration Parameters 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Security: 
Password 

WebUI 
password 

20 
characters 

Siemens Sets the password the user must enter to 
access the WebUI. 

Session 
Inactivity 
Timeout 

5 to 60 
Minutes 

20 
minutes 

The number of minutes of inactivity before 
the WI will automatically log out a 
connected user from the WebUI. 

 
Table 5-12   Security: WebUI Configuration Parameters 

Web UI Screen Parameter 
Name 

Range Default Description 

Security: WebUI 
Configuration 

Browser 
Access 

Secure 
(https) or  
Non-Secure 
(http) 

Secure 
(https) 

Whether the web browser is 
accessed using http or https.  
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5.9 WAYSIDE MESSAGING SERVER AND SIEMENS DIGITALIZATION INTERFACE 

Table 5-13   WMS Interface Configuration Parameters 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Digi Intf 
Settings 

Digitalization 
Interface Enabled 

Yes, No No The digitalization interface may be enabled 
or disabled with this setting. 

Encryption 
Enabled 

Yes, No Yes If set to Yes, the WI will encrypt 
digitalization messages using the specified 
encryption key. 

Encryption Key 1 to 20 
characters 

Encryptkey#1 If encryption is enabled, this key will be 
used. 

Message 
Authentication 
Key 

1 to 20 
characters 

MacKey#1 Each digitalization message is 
authenticated using a message 
authentication code (MAC). This field 
specifies the key to use in the message 
authentication process. 
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Table 5-14   WMS Class D Configuration Parameters 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

Class D 
Settings 

Application 
Gateway IP 
Address 

0 to 64 
characters 

10.255.255.210 Specifies the IP address of the 
application gateway service to use for 
communication. 

Application 
Gateway Port 

1024 to 
65535 

3001 Specifies the TCP port number to use for 
the Class D connection to the application 
gateway. 

Keep Alive 
Interval 

0 to 60000 
ms 

30000 Specifies the interval between Class D 
keep alive ack messages. 

Keep Alive Ack 
Timeout 

0 to 60000 
ms 

30000 Specifies the timeout for Class D keep 
alive ack messages. 

Ack Timeout  0 to 60000 
ms 

15000 Specifies the timeout for Class D ack 
messages. 

Connect Attempt 
Timeout  

1 to 60000 
ms 

30000 Specifies the connection timeout for 
Class D connections. 

Connect Attempt 
Delay  

1 to 60000 
ms 

60000 Specifies the delay between attempts to 
connect. 

Connect Attempt 
Retry Count 

-1 to 10000 -1 Specifies the limit on connection 
attempts. A value of -1 means the WI will 
attempt to connect indefinitely. 

Reconn. Attempt 
Retry Limit 

-1 to 10000 -1 Specifies the limit on reconnection 
attempts. A value of -1 means the WI will 
attempt to re-connect indefinitely. 

Data ACK 
Enable 

Yes, No Yes Enables or disables data ack messages. 

Data Ack 
Timeout 

1 to 60000 
ms 

15000 Sets the time for data ACKs. 
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Table 5-15   WMS EMP Parameter Values 

Web UI 
Screen 

Parameter 
Name 

Range Default Description 

EMP 
Settings 

Wayside Inspector 
EMP Addr 

0 – 64 
characters 

wi.w:1 The EMP address used for the WI unit. 

MindConnect Rail 
EMP Addr 

0 – 64 
characters 

mcr.o:1 The EMP address used for the MindConnect 
Rail server, which is the digitalization gateway 
system for the WI. 

EMP TTL 0 to 65535 1 Specifies the EMP TTL value to use in 
digitalization messages. 

EMP QOS 0 to 65535 1 Specifies the EMP QOS value to use in 
digitalization messages. 
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CHAPTER 6 – INSPECTION SCHEDULE TEXT FILE FORMAT 

The Inspection schedule file is an ASCII text file using the following format: 
 

# Lines starting with a pound (#) sign are ignored and 

# used for comments. Blanks lines are also ignored. 

 
# Inspection schedule xxx; version 1.0; June 3, 2015 

Q  01-JAN-2015 00:00 

 

A  03-APR-2016 23:30  Text following the date/time is ignored 

 

M  07-MAY-2015 08:45 

M  07-JUN-2015 08:45 

M  07-JUL-2015 08:45 

M  07-AUG-2015 08:45 

M  07-SEP-2015 08:45 

 
The file format has the following attributes: 

• File is in ASCII text 
• Blank lines are ignored 
• Lines starting with a ‘#’ sign are ignored and can be used for comments 
• A schedule entry starts with a single character, signifying the type of inspections for the 

following date and time: ‘A’ for annual inspections, ‘Q’ for quarterly inspections, ‘M’ for 
monthly inspections, and ‘W’ for weekly inspections. 

• At least one whitespace is required between the data fields in each schedule entry. A 
whitespace is defined as a space or tab character. Multiple whitespaces are allowed. 

• Text following the date and time is ignored.  At least one whitespace character must 
follow the time. 

• The schedule entries are not required to be in chronological order 
• The date must use the following format DD-MMM-YYYY and use all characters where 

DD is the day number (01-31), MMM is the month (JAN, FEB, MAR, …), and YYYY is 
the year (e.g. 2016). 

• The time must use the following format hh:mm and use all characters where hh is the 
hour in 24-hour format (00-23), and mm is the minute (00-59). 
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